
 
Visual Staff Scheduler® 

User’s Guide 
Pro & Premier versions 
 

Congratulations on choosing Visual Staff Scheduler (VSS), the #1 staff scheduling software!  In  just a few minutes, you’ll 
learn how VSS Pro & Premier versions help you schedule your staff and spend less time doing it. 

Fast. VSS is the fastest and easiest scheduling system available, and getting started is easy as 1 ‐ 2 ‐ 3. Simply list your 

employees, define your shifts, and start scheduling! It’s really that fast. 

Easy. VSS is packed with powerful features to help you build your schedule and keep track of your staff. With VSS, you 

can perform all your scheduling  tasks  from a single, easy‐to‐use  interface. Plus, you  tell VSS what you want  to see on‐
screen. 

Flexible . Customize VSS  to print, publish, or e‐mail  schedules and  reports  in  just about any  format you can  imagine. 
Whether you need daily, weekly, or monthly schedules for a department, shift, or multiple locations, VSS can handle it all – 
all from the same schedule file. No matter how complex your scheduling needs, just tell VSS what you want to see on the 
schedule.  

We’re  here   to  help  you!  If at any time you have a question about VSS, give us a call at 1‐701‐235‐5226. We are more 
than happy to show you just how easy scheduling can be with VSS.  

Overview 

VSS uses a visual database that allows you to see, in advance, scheduling conflicts. The visual database, together with the 
flexible worksheet design, allows VSS to deliver tremendous power, without sacrificing ease of use. The perpetual calendar 
allows you to schedule as far into the future as you want. 

VSS defaults the file starting and ending dates to span a two‐year time frame. There is no need to create separate schedule 
files for different time periods (e.g., one week, six weeks, six months, one year, four years, etc.). 

Here are just a few things you can do with VSS:  
• View, print, publish, or e‐mail any schedule or report  
• Ensure shift coverage  
• Improve accuracy  
• Track time‐off and vacations  
• Avoid schedule conflicts  
• Make changes quickly  
• Rotate schedules easily  
• Estimate labor costs  
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• Share information with time & attendance systems  
• Save time  

Why Use VSS? 

There are literally hundreds of reasons why you should schedule your staff with VSS. Here are just a few of them:  

• Schedule your staff quickly and easily, saving you time and frustration. 

• Enter last minute changes and eliminate re‐entering valuable scheduling data. 

• Pre‐schedule time‐off requests and rotations (i.e. alternating weekends off) as far into the future as you want.  

• Calculate staffing levels and shift coverage by position, group, location, department, etc.  

• Gain instant access to any date or scheduling period.  

• Print clean, professional‐looking, schedules and reports in just about any format you can imagine. 

What’s in the New Pro & Premier Versions? 

Visual Staff Scheduler is designed to be the most powerful scheduling tool you have ever used. If you used a previous 
version, you’ll want to review these new features included in the most recent VSS Pro and Premier. 

New  Schedule  Notes  

Share comments about the schedule file or worksheet by adding Schedule Notes. Notes can communicate messages to 
those who have read/write access to the schedule. You can choose to have the notes displayed when the file is opened, 
such as “All day shift vacation requests received this week are entered. Please enter any requests received from the 
weekend shift before Monday.” 

Day  Watch  Display  

Open the new Day Watch view at the bottom of your schedule worksheet to display a bar chart that illustrates the number 
of employees you have assigned for each hour as you select a day. You can sort employees in this view by skill, or group of 
skills, and view all or view within a divider. 

Improved  Display  

New access points make popular features even easier to access and use, like the new quick‐action buttons that show or 
hide Schedule Assistant, Coverage Totals, and Day Watch. 
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About this Guide 

The Visual Staff Scheduler User’s Guide is written for end‐users who have a need to schedule staff quickly and efficiently. The 
focus of this guide is how to use VSS. The best way to quickly become familiar with this scheduling system is to review these 
three sections of the guide.  

Review  the  “Overview”  and  “What’s  New”  sections. These sections provide a description of the VSS basic 
functions and describe some of the new features in this version.  

Install  VSS.  The section explains how to use the Setup program to install VSS and example schedule files. You can 

install VSS under Microsoft Windows® 2000/XP/Vista.  
Review  “Quick  Start  –  A  Tutorial.”  This section provides simple, step‐by‐step instructions and gets you started 
using the basic features and functions of VSS. 

FINALLY.  .  .  start  using  VSS!  When you need more detailed information, refer to the remaining sections of this 
guide.  

This user guide assumes you are already familiar with Microsoft Windows 2000/XP/ Vista operating systems. It also 
assumes you know and understand the basics of operating a mouse. If you need more information about Microsoft 
Windows 2000/ XP/Vista, or operating a mouse, please refer to their respective manuals. 

How  this  Guide  Works  

The following conventions are used in this user’s guide:  

Alt key combinations are active in VSS. Simply press the Alt key on your keyboard to see the underlined letters used for 
the various menu commands. For example, Alt + E displays the Edit menu. Alt + E followed by Alt + C is the Copy command 
from the Edit menu. 

Information of special interest, or VSS information of which you should make a special note, is set apart in a “Note:” 
paragraph. 

All menu names and commands are identified in the guide and used in step‐by‐step instructions that describe how to use 
the tools and features of VSS with numbered lines. 

Help  Content  

When you need help with a specific function, command, or procedure, select Contents in the Help menu. For more 
information on using Help, refer to your Microsoft Windows User’s Guide. You can also click the Help button when it is 
displayed on any of the windows you’re using. 

VSS also provides tool tips that are displayed when you pass your cursor over a specific function or button. 
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Online  Resources  

A quick and easy way to access the ABS web site is by selecting Online Resources from the Help menu. Here you can learn 
more about your VSS staff scheduling software, as well as other valuable business software offered by ABS.  

Technical Support  

If you can’t find the answer to your question, after first consulting this documentation or the Help menu, contact Technical 
Support via 

• Internet E‐mail:  support@abs‐usa.com  

• Online Support:  http://www.abs‐usa.com  

• Telephone:  1‐701‐235‐5226  (8:00 AM to 5:00 PM, CST, Monday through Friday) 

Free Technical Support Period 

ABS offers 90 days of free technical support to registered VSS users. Free technical support starts from your date of 
purchase. Thereafter, there is a $35 charge per incident. ABS also offers 12‐month, unlimited Technical Support Plans 
and Software Enhancement Plans. For just pennies a day, we can help keep your software up and running. 

Technical Support Plans 

• Unlimited telephone and e‐mail access to ABS Support Technicians 
• FREE media replacement should your software become lost or damaged 
• For Technical Support Plan pricing, please call 1‐800‐874‐8801 

Software Enhancement Plans 

ABS offers 12‐month, Software Enhancement Plan entitling you to FREE upgrades to the next version of VSS, in 
addition to everything included in a Technical Support Plan. For Software Enhancement Plan pricing, please call: 1‐
800‐874‐8801. 

Installing VSS 

This section describes how to install VSS to run under Windows 2000/XP/Vista, and how to install multi‐user versions of 
VSS on a network server or workstations. 

What  You  Need  to  Run  VSS    

The minimum software and system configuration you need to run VSS includes:  

• A personal computer with a Pentium Processor (75+ MHz, and at least 64 MB of memory).  
• One CD‐ROM drive and a hard disk with at least 20 MB of free disk space for VSS files, plus additional disk space for 

schedule files.  
• VSS requires Windows 2000/XP/Vista.  
• A mouse supported by Microsoft Windows is recommended.  
• A compatible monitor supported by Microsoft Windows. (VSS supports VGA and Super VGA monitors; however, a 

SVGA monitor is recommended.)  
• An optional printer supported by Microsoft Windows.  

Installing  VSS  

For multi‐user versions of VSS, please refer to the instructions presented after the single‐user instructions described 
below.  

Note1: Close all applications, including screen savers or similar programs, before running the Setup program. 
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Note2: The VSS setup program creates a Windows program group named ABS Applications, and inserts the Visual Staff 
Scheduler program icon. 

TO INSTALL VSS SINGLE‐USER VERSIONS (WINDOWS 2000 OR HIGHER):  

1 Place the VSS CD in your CD ROM. 

2 If the application does not auto‐run, click the Start button and select Run from the Start menu. The Run window is 
displayed. 

3 Type D:\setup.exe in the window (or, use the appropriate drive letter for your CD‐ROM drive). The setup program 
launches. To continue, click Next.  

4 Review the License Agreement and click Next.  

5 VSS displays the Select Destination Directory window. The Setup program will install VSS software to the 
directory C:\Program Files\VSS. It will automatically create the directory on your hard disk, if you haven’t done so 
already. If you want to install the program to another directory, browse through the folder list and select a 
destination directory. 

6 Click Next to continue. VSS starts copying the program files to the designated directory. 

7 VSS is ready to start the installation. Click Next to begin. 

When the setup program is finished, VSS displays the message— “Visual Staff Scheduler has been successfully 
installed.”  

8 Click Finish to complete the installation. 

The Setup program automatically adds “Visual Staff Scheduler” to the ABS Applications group. 

 

TO INSTALL VSS MULTI‐USER VERSIONS (WINDOWS 2000 OR HIGHER): 

First be sure you have a network and a need to share data between several workstations. If you do not have a network, 
or a need to share data across several workstations, use the Setup program. Otherwise, use the NSetup program 
described as follows. 

Network Server Installation 

1 Click the Start button and select Run. 

2 From the Run window, type D:\nsetup. (or, use the appropriate drive letter for your CD‐ROM drive).  

3 Click OK, or press the Enter key.  

4 When prompted by the setup program, enter the network drive and directory where you want the program 
installed. For example, enter F:\VSS.  

5 Click OK, or press the Enter key. The NSETUP program will copy the application files along with a workstation 
setup program to the specified network drive. Go to a workstation where you want to install the workstation 
setup files. 

Client Workstation Installation 

1 Click the Start button (at the client workstation) and select Run. 

2 Type F:\…\wksetup in the window. (or, use the appropriate letter for your network drive and directory where VSS 
was installed, i.e. the same directory and pathname that was used in step 4 above.) 

3 Click OK, or press the Enter key. 

This will install all the required dependency files on the workstation as well as create icons for program startup. 

4 Start VSS by clicking Start, and selecting Programs>ABS Applications>Visual Staff Scheduler. 
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Important Note About Network Installations 

If you purchased a VSS multi‐user license, but do not have a network, or do not wish to install the multi‐user version 
on a network, you can install VSS on as many workstations as you have licenses. The only legal requirement is that you 
must install all copies within the same company. You cannot purchase one copy of the multi‐user version and install it 
at more than one company or location. 

As an option, you can install a complete copy of the software on individual workstations using the appropriate Setup 
program. For installation instructions, refer to page 8. You may want to use this option because a user does not want 
to boot his or her system from the network or he/she wants to be able to run VSS if the network server is not available. 
In this situation, data (local schedule files) can still be accessed. 

You are ready to begin! Review the next section, “Quick Start—A Tutorial”, to learn more about using VSS. For more 
information on multi‐user installations, please refer to the readme.txt file on your VSS CD. 

Quick Start – A Tutorial 

This section describes how to use the basic functions of VSS by completing a self‐paced tutorial using the sample file 
Service Department.vsc. 

Getting  Started  

This quick tutorial will get you started using VSS as you practice making shift assignments using the Service 
Department.vsc file as an example. 

Note: If you are already familiar with an earlier version of VSS, you may feel comfortable skipping this section. 

TO START 

1 Start VSS by clicking the Start button and selecting Programs > ABS Applications > Visual Staff Scheduler. 

2 If this is the first time you’ve used VSS, follow the displayed registration instructions. Click OK. 

Note: Remember to register in order to receive discounts on future products and upgrades, 30‐day free technical 
support, and early notification of new product releases.  

3 Click the Open Sample Schedule button in the Welcome screen, or select Open from the File menu. Select Service 
Department.vsc in the Open File window, and click Open. 

4 VSS opens the sample file displayed in the 28‐Day view (one of VSS’s many view options). This sample may not 
have the look you would like for your schedule…don’t worry! You’ll learn about customizing a little later. 

SCHEDULE VIEWS 

Unless you have more than 500 employees, all scheduling can be done in one schedule file, and from one or more 
views. VSS gives you five custom views so you can see your scheduling information with different levels of detail. 
These views are: 

• One‐Day 

• One‐Week 

• 14‐Day 

• 28‐Day 

• 42‐Day 

In any view, you can print any schedule or report. 
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Each view provides up to 42 days of information on‐screen. This lets you view schedule details, while also seeing the 
“big picture” with just a click. With VSS, you can use daily, weekly, bi‐weekly and four‐week views, depending upon 
your needs and preferences. 

Using the View menu, select these options so you can see the difference in the appearance of the sample schedule as 
you change the viewing option. 

 

MENUS & TOOLS 

Before getting started, become familiar with the location of these menus and tools. 

Menu Bar 

At the very top of the screen is the VSS menu bar. The menu bar lists the available menus that contain commands or 
actions you can perform. Menus include: 

• File 

• Edit 

• View 

• Define 

• Reports 

• Help 

Shortcut Keys 

You can perform VSS's commands using the mouse to select a function from the appropriate menu, or by pressing a 
shortcut key like Ctrl+A to assign a shift. 

Quick‐Action Buttons 

Below the main menu bar is the tool bar, which contains a series of quick‐action buttons. The quick‐action is identified 
by a picture icon. For example, you can complete some scheduling functions with the assignment buttons, such as 
assigning and erasing shifts. Other buttons allow you to move forward/backward one day or page, view hourly 
coverage, and send e‐mail by clicking the tool bar. 

When you’re using one of these functions, the quick‐action button will be displayed with an active status indicator. 
This means there is a highlighted box that appears around the quick‐action button to show it is “in use.” 

Scrolling Features 

To navigate VSS’s spreadsheet‐like schedule worksheet, use your keyboard arrows or the main window’s scroll 
arrows/scroll bar. Or, you can quickly move up and down through the main window using the scroll wheel on your 
mouse. 

TASK PANE 

The Task Pane gives you quick access to specific schedule dates, commonly used features, and procedures for using 
VSS tools. By selecting Task Pane from the View menu, or clicking the Task Pane quick‐action button in the tool bar, 
you can add or remove the task pane details from your schedule worksheet. 

Calendar 

Use the calendar to select a specific date to display in the schedule worksheet. 

Common Tasks 

A list of links to the most frequently used scheduling features that do not have quick‐action buttons in the tool bar. 

How do I? 
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A list of links to content topics that answer the most frequently asked questions by customers. 

SCHEDULE OVERVIEW 

Review this information to become familiar with your schedule. 

Schedule View 

Remember, by selecting one of the five custom views, VSS shows your scheduling information with different levels of 
detail, such One‐Day or 14‐Day. 

 

Display Days 

Each view can display from a single day up to 42 days of information on‐screen at a time. You can click the Move 
Forward/Backward One Day button to see how the schedule dates change. 

Again, this is the feature that lets you view schedule details, but also see the "big picture" with just the click of the 
mouse. 

Cell Indicators 

There are a number of cell indicators that show current information about the day(s) you have highlighted. You’ll learn 
more about these indicators as you work through the step‐by‐step instructions. 

Schedule Worksheet 

In the middle of the VSS main screen is the spreadsheet‐like scheduling worksheet. The schedule worksheet is 
arranged in rows and columns. At the top of the worksheet are the Name, Position, and Date column headings. 

Identification Columns 

The left‐most column, Name, allows you to enter up to 500 names per schedule file (i.e. Amy Johnston). The second 
column, Position, allows you to enter a position description (i.e. Manager) for the name you entered in the first 
column.  

Hours Column 

You can add the Hours column to display the total number of hours for each employee scheduled in the date range 
you are viewing. It follows the Name and Position columns at the left of your schedule. 

Scheduling Information Columns 

The multiple columns to the right of the Position column make up the balance of the schedule worksheet. This is 
where you enter shifts (i.e. 8 a.m. to 5 p.m.), explanations, such as a location, department, or job (i.e. Store #75), notes 
(i.e. Expect delivery at 10 a.m.), and other scheduling information. Each column heading is automatically labeled with 
the day of the week and the date. 

Employee Name & Date Highlighter 

Click a cell in the schedule worksheet and take note of the Name column; the name or title will have an arrow 
indicator. Next, navigate up and down through the schedule and watch the arrow indicator keep track of where you 
are within the schedule. 

You will also see a dark border around the corresponding date at the top of the schedule to help you identify schedule 
dates as you navigate the schedule. 

Let’s  Practice  

Continuing in the Service Department.vsc file as an example, follow these simple, step‐by‐step instructions to practice 
using the VSS software. 

ADD NAMES  
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1 Click Add New Employee in the task pane, or locate the first blank row in the schedule by scrolling down, if 
needed. 

2 Click a cell in the Name column and the Employee Profile window opens. 

Note: You can also go to the Define menu and select New Employee or the Edit menu and select Insert > New 
Employee. These actions also open the Employee Profile window, where you can enter information to add 
employees to the schedule. 

3 Enter the employee name in the General tab of the Employee Profile window. Employee Name is the only 
required field to begin scheduling. 

4 Click the Position/Skills tab and enter John Doe’s position, such as Sales, Technician, Manager, or Assembler. 

Note: You can also import CSV and TXT files to add employees. 

5 Enter one or more additional names and positions. 

Note: Users of QuickBooks Pro/Premier 2003 or Enterprise 2.0 (or newer versions) can import employee names 
and other information, such as employee numbers and e‐mail addresses (when available), from a QuickBooks 
company file. 

ASSIGN A SHIFT 

In the Service Department.vsc file, shifts are already defined and you can practice assigning them with the Assign Shift 
button. Click the Shift Selector list box located directly above the tool bar to see all the shifts defined in this sample 
schedule file, such as Day, Evening, and Night. 

To Assign Shift 

1 Click the first cell, or day, in the row established for John Doe. Notice how the day is highlighted and labeled (i.e. 
Mo 1‐1 indicates Monday, January 1). 

2 Click the Assign Shift button and the cell displays the shift scheduled for John Doe. 

Note: Abbreviations are used as you increase the number of days in your schedule view. For example, in the 28‐
Day and 42‐Day view, you may notice the abbreviation (D), for Day, is placed in the cell, or day, you selected. John 
Doe is now scheduled for the Day shift on Monday, January 1. 

3 Click to highlight the next cell, or day, for John Doe. 

4 Assign a different shift by clicking the drop‐down arrow next to the Shift Selector. Notice the other defined shifts 
that appear in the list box. 

5 Click the Evening shift and the Evening shift selection now appears in the Shift Selector. 

6 Click the Assign Shift button and the cell displays Evening shift. 

Note: Each abbreviation, or symbol, in the rows and columns represents different types of scheduling information 
contained in a cell. You can customize VSS to use abbreviations or full descriptions. It’s up to you! 

READ YOUR SCHEDULE 

Regardless of how many days you have showing on your screen (i.e. what view you’re in) or how much detail is 
showing in the schedule worksheet, you can always read what information each day contains by selecting a cell and 
referring to the Cell Indicators. 

Select other days in the schedule worksheet to see what the other abbreviations represent. Detailed cell information is 
displayed in the cell indicators, located in the upper left‐hand corner of the screen, and in the Explanation list box and 
Notes Entry area. 

ADD EXPLANATIONS TO YOUR SCHEDULE 
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Practice adding locations, departments, etc. (called Explanations) to shifts, and scheduling time‐off by completing the 
next instructions. 

Explanations are most commonly used for adding detail to shifts. Since shifts (except "OFF") indicate a start time and 
end time, explanations describe what a person should be doing on a particular shift or where he/she should be working 
for a particular shift. 

To Add Explanations 

1 In the upper left‐hand corner of the screen is the Explanations Selector. Click the drop‐down arrow next to the 
selector to display the explanations created for the Service Department.vsc file. 

2 To add an explanation to the list, select Explanations from the Define menu. The Define Explanations window is 
displayed. 

3 Select and highlight an undefined explanation in the list box. 

4 In the Description box, enter an explanation that describes a location for the shift, such as Bldg A. You can define 
any type of explanation you want: Location, Jury Duty, Illness, Department Name, etc. 

5 Tab to the Abbreviation box and type an abbreviation for the explanation (up to five characters), such as "BA" for 
Bldg A. Abbreviations are used when the full description cannot fit in cells. 

Note: There is also a Quick Key box that allows you to enter the keystroke you want to use when applying the 
explanation. 

6 Click OK. VSS returns to the schedule worksheet. 

7 Click the drop‐down arrow next to the Explanations Selector to view the explanation(s) you just defined. 

8 To apply the explanation to a shift in the schedule, select a cell with an assigned shift; for example, click the first 
Day shift (D) for Frank Rossi, Manager. 

9 Select Bldg A from the Explanations Selector, and notice how VSS attaches the explanation symbol to the cell. 

Note: For views that are not set to display explanations on screen, VSS places a blue box symbol in the upper left‐
hand corner of the cell to indicate an explanation has been attached to the cell. If you view the schedule for one 
day, the complete explanation displays in the cell. 

SCHEDULE TIME‐OFF 

Use the Time‐Off button to schedule an employee's vacation request or time‐off due to illness, personal leave, 
training, etc. 

To Schedule Time‐off 

1 If necessary, move to the end of the schedule worksheet and click on an empty cell for the new name you entered. 
VSS highlights the date cell. 

2 Click the quick‐action button for assigning time‐off. 

Note: VSS fills the date cell with [OFF] or an [X] to indicate a day off. "OFF" is displayed in the Week or 14‐days 
views. 

SAVE YOUR SCHEDULE 

For future reference, save the schedule you just modified. Since someone else may want to use the Service 
Department.vsc file, follow these steps to save the schedule with a different file name. 

To Save Schedules 

1 Click the File menu and select Save As. VSS displays the Save As window. 

2 Select an appropriate directory and type in a new file name. 

3 Click Save. 
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Congratulations!  You just finished a quick lesson on how to use some of the basic features of VSS. Once you get 
started setting up your own schedules, you will see how easy it is to create schedules, plus assign shifts, time‐off, and on‐
call status to the schedules.  

Remember, you don’t have to create separate daily, weekly, or monthly schedules, because VSS uses a perpetual calendar. 
You only have to decide which part of the calendar you want to view and use. 

Setting up Your Schedule File 

In this section you will learn how to create your schedule file and set it up to meet your specific scheduling needs. Topics 
included are: 

• Create your own schedule file  

• Define your schedule file’s beginning and ending dates  

• Enter names and positions  

• Importing files and QuickBooks data  

• Insert a divider to organize names in groups, such as by department  

• Sort names and positions  

• Find a name  

• Include comments and photos 

• Define shifts, explanations, coverage totals, and employee information  

• Set reminders and file properties 

• Set and view the Usage Log  

• Saving your schedule file  

• Open an existing schedule file 

WELCOME SCREEN  

A dashboard appears each time you run VSS. It provides quick access to functions for opening your last schedule, 
creating a new schedule, or opening an existing schedule. Click the button for the function you want to complete. 

You can change your settings to bypass the welcome screen by creating a shortcut to your schedule file: 

1 Right click your desktop, select New and Shortcut. 
2 Type or Browse to identify the location of your schedule file. 
3 Click Next. 
4 Type a name for the shortcut. 
5 Click Finish. 

Begin  a  Schedule  

Using the File menu you will set your file properties, as well as create, open, save, close and print VSS schedule files.  The 
option to import employees from QuickBooks is also found here. 

CREATING A NEW SCHEDULE FILE 

When you create a new schedule file, VSS defaults your file starting and ending dates to two years in length. Even if 
you only need daily, weekly, or monthly schedules, you should create a schedule file long enough for you to pre‐
schedule shifts, rotations, and time‐off requests. 
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You do not need to create individual schedule files for different time frames. Schedules for any time period and group 
of people can be created easily using many of the built‐in functions in VSS that do the sorting and filtering for you. 

To Create a New File 

1 Select File from the menu bar and select New. 
2 Enter a file name in the File name box and click Open.  
3 Click Yes to create the new file. 

To set your file properties, such as the starting and ending dates, as well as the beginning day of your schedule, go to 
File > Properties. You can set up a password to restrict access to your schedule file, or if you have a multi‐user version 
of VSS, you can also set a password for read/write and read‐only access. 

Note: If you forget your password, you will not be able to access the file. You will need to contact ABS Support. Unless 
you purchased a Technical Support Plan or Software Enhancement Plan, a $50 unlock charge will apply. Call to speak 
with a representative at 1‐701‐235‐5226 for more information. 

OPENING A SCHEDULE FILE 

You can open an existing schedule file in the Welcome Screen by clicking either the Open Existing File or Open 
Previous File button. You can also use the File menu to open existing schedules. You can have one schedule file open 
at a time. 

If a schedule file is in use, multi‐user versions of VSS will allow other users to view the last saved schedule file in read‐
only mode. 

To Open a Schedule File 

1 Click File and select Open. VSS displays the Open File window. 
2 Select a schedule file to open from the list box. (VSS schedule files have a .VSC file extension.) 
3 Click OK. VSS opens the selected schedule file. 

If you’re using a multi‐user version of VSS, the File in Use window will inform you when a schedule file is being 
accessed by another user. When the schedule file is in use, you can choose to open a read‐only version of the file, or to 
receive a notification with the schedule file becomes available for editing. 

Note: If you minimize your VSS screen, the VSS icon located in the Windows task bar begins to flash when the 
schedule file is available. Click the VSS icon in the task bar and continue. 

OPENING CONCURRENT SCHEDULE FILES 

Multi‐user versions of VSS allow you to open more than one schedule file at the same time. This functionality gives 
you the ability to view and edit multiple schedule files concurrently. 

Note: When using concurrent schedule files, copying from system to system is limited to basic text. 

To Open Concurrent Schedule Files 

1 Launch an additional instance of VSS. 
2 Open the desired schedule file. 
Note: Some display preferences will not be retained when subsequent instances are closed and the System Registry is 
unable to track unique instances. 

SAVING YOUR SCHEDULE FILE 

It’s always a good idea to save your schedule file periodically in case your computer system loses power, or to prevent 
the loss of schedule information from other unforeseen circumstances. 

To Save a Schedule File 

Use the File>Save command to save any changes made to a schedule file. 

To Save an Existing File with a New Name 
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The File>Save As command allows you to save an existing schedule file to a different name. Consider saving your 
schedule files to different names before you start making changes to the schedule. Then, you will be able to revert 
back to a copy of the schedule if you made undesired changes to the new schedule. 

To Automatically Save a Schedule File 

The Auto‐Save default setting in VSS is “Off.” It is recommended you activate the Auto‐Save feature, instructing VSS 
to automatically save your work. 

1 Select Properties from the File menu. 
2 Click the Automatically Save Schedule list box, and select the time frequency (i.e. every minute, every 10 minutes, 

or other) for saving your file. 
3 Click OK. 

IMPORT EMPLOYEE INFORMATION USING QUICKBOOKS 

For users of QuickBooks Pro/Premier 2003 or Enterprise 2.0 (or newer versions), employee information can be 
imported into your schedule file from your QuickBooks company file. The information includes: 

• Employee names 

• E‐mail addresses 

• Employee or account numbers 

• Phone numbers 

• Alternate phone numbers 

• Mailing address 

• Hire date 

You can use the import feature to update your VSS database at any time. VSS will only import the new employee 
names you have added to your QuickBooks file. 

Note: When you make changes to an existing employee name in QuickBooks, these changes cannot be imported. You 
will need to make the same name changes in VSS manually. 

To Import Employee Information from QuickBooks 

1 Open your QuickBooks company file, and return to VSS. 
2 Select a row in the Name column where you want the imported name(s) to appear. 

Note: You can always relocate employees after the import to other areas of your schedule using the instructions 
in Moving Names and Schedule Information. 

3 Click File and select Import from QuickBooks. 
4 Click the checkbox to give VSS access to personal data. 
5 Select from two options to allow access to QuickBooks: 

• Yes, This Time 
• Yes, Always 

6 Click Yes to allow access. 
7 Select the Name Format you want to use and click OK to import employee information from the open 

QuickBooks file. 
8 Click OK. 
TIP:  Before beginning a new import, it is recommended you save your VSS schedule file. Then, if for any reason you 
choose to return to your schedule as it appeared before the import, you are able to do so by closing VSS without 
saving the file. When you re‐open your VSS schedule file, the imported information will not be there. 

SETTING UP FILE PROPERTIES 
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The File > Properties function allows you to setup, or edit, the starting and ending dates and beginning day of your 
work schedule. You can also set up a password to restrict access to the work file and set E‐mail and Data Export 
options. 

To Set up Your Schedule File Properties 

General Tab 

1 Enter the beginning date in the File Starting Date box. 

2 Enter the ending date in the File Ending Date box. 

Note: VSS defaults the file starting and ending dates to span a two‐year time frame. There is no need to create 
separate schedule files for different time periods (e.g., one week, six weeks, six months, one year, four years, 
etc.). From a single schedule file you can print, publish, or e‐mail any schedule or report. Make sure your schedule 
file extends far enough into the future to accommodate time‐off and pre‐scheduled shifts. 

3 Enter the optional Access Password (Read/Write or Read Only) for this schedule file. 
Note: VSS allows you attach a different password to each schedule file you create. The system will ask you to 
enter this password when you attempt to open the schedule. VSS will not ask for a password if you leave this field 
blank. If you have the multi‐user version of VSS you can assign Read‐Write and Read‐Only passwords to each 
schedule file. 
Important! Be sure to write down the password and keep it in a safe place so others cannot access your 
confidential information. If you lose your password, you will need to contact customer support for information on 
how to regain access to your information. 

4 Select the frequency desired in the Automatically Save Schedule box; deactivate this feature by selecting OFF. 
5 Click to select the day of the week your regular workweek begins (i.e. Sunday, Monday, etc.). 
6 Identify the location of your Staff Files application, if needed. Notice, you also connect your Staff Files 

information from this window. 

E‐mail Tab 

1 Mark or unmark check boxes to make your selections for the Before Sending Schedules options: Display default E‐
mail editor, Display default address book, and Send directly to Outbox. 

2 Mark or unmark check boxes to make your selections for the When Mailing Schedules options: Send copy to 
participants, Ignore missing or invalid addresses, and Request a return receipt. 

3 Click the Restore Defaults button to reset to original settings, if needed. 

Data Export Tab 

1 Mark the Enable Auto Export option to automatically export your schedule data whenever you select Save from 
the File menu. 

2 Enter or select your Date Range settings. 
3 Mark to activate the Require Employee Numbers option. 
4 Click OK. 

Default Folder Tab 

1 Click the Default button to make the listed folder the preferred folder for locating your VSC files. 
2 Click the Change button if you need to identify a different folder as the preferred folder for locating your VSC files. 
3 Click OK to save your settings. 

14  Visual Staff Scheduler 

 

mk:@MSITStore:C:%5CUsers%5CBelinda%5CABS%20Documentation%5CVSS%20PRO%2011%5CVSS%20PRO%2011_Help%5C!SSL!%5CMicrosoft_HTML_Help%5CVSSPRO10.chm::/VSSPRO5_2_rtf/Saving_a_Schedule_File_with_Auto_Save.htm
mk:@MSITStore:C:%5CUsers%5CBelinda%5CABS%20Documentation%5CVSS%20PRO%2011%5CVSS%20PRO%2011_Help%5C!SSL!%5CMicrosoft_HTML_Help%5CVSSPRO10.chm::/VSSPRO5_2_rtf/Staff_Files.htm


 

CHANGING THE PROPERTIES OF EXISTING SCHEDULE FILES 

VSS is designed to allow you to maintain a perpetual schedule file that can span many days, months, even years. You 
may increase or decrease the number of days in the schedule at any time. For example, if you originally created a file 
for the year 2009 and now need to add another year to pre‐schedule upcoming vacations, simply enter your new File 
Ending Date (i.e. 12/31/2010). VSS automatically expands the size of the file to accommodate the new year. Likewise, 
as years go by, some information contained in the file may become outdated. Moving the File Starting Date forward 
informs VSS that you wish to remove out‐of‐date information. This also allows you to reclaim some of your valuable 
hard disk space. 

To Change the Starting/Ending Date of Your File 

1 Select Properties from the File menu. 
2 Enter the new beginning date in the File Starting Date box. Or, Enter the new ending date in the File Ending Date 

box. 
Note: The system warns you if a change you have made to either the Starting or Ending dates will remove days 
from the file. 

3 Click OK to accept the changes, or click Cancel to abort the procedure. 

SETTING & VIEWING THE USAGE LOG 

VSS automatically logs usage information each time the schedule file is opened or updated. The date, time, user’s 
network, and computer name are saved for audit trail purposes. The Usage Log maintains up to 500 scheduling 
session records. 

Note: To keep the integrity of the audit trail, session comments are not reversible and cannot be changed. 

To Set and View the Usage Log 

1 Select Usage Log from the File menu. 
2 Mark the Prompt for session comment before saving file check box to require users to enter an explanation for 

their session usage before closing the schedule file. 
3 To cancel, simply unmark the check box.  

Define  Schedule  Information  

The Define menu contains commands for defining new employees, shifts, explanations, coverage totals, and inactive 
employees. 

DEFINING SHIFTS 

Because no two companies or businesses are alike, VSS allows you to define your own shifts.  

Shifts are used to indicate when a person will work or have the day off. For example, you might have a day shift that 
starts at 8:00 a.m. and ends at 5:00 p.m., or an afternoon shift that starts at 1:00 p.m. and ends at 6:00 p.m. A shift 
called “Off” is already defined for you. This shift is used to indicate when someone has the day off.  

To add information to shifts, such as department, task, location, sick, vacation, etc., refer to the section “Defining 
Explanations.”  

To Define a Shift 

1 Select Shifts from the Define menu. This displays the Define Shifts window.  
2 Select a shift in the Shift Selector list box; “undefined” for a new shift. 

Note: The first three items in the Shift Select list box (Time‐Off, On‐Call and Note) are predefined, special items. 
These items can be edited like any other shift, but only their Descriptions and Abbreviations can be changed. 

3 When you select a shift other than Time‐Off, On‐Call, and Note, additional options appear in the window. Make 
your selections for: 
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Description. A shift description can contain any text and can be up to 15 characters in length. 
Abbreviation. The Abbreviation enables you to create a shorthand shift designation to be used on reports and 
edit screens where there is not enough room for the full shift description. Abbreviations can be up to 5 characters 
long, but you may want to keep them shorter so they can easily fit on all the schedule formats you create. 
If you are using a format that displays abbreviations instead of full descriptions, you can print the Legend Report. 
The legend can list all shift and explanation abbreviations along with their associated full descriptions, quick keys, 
etc. 
Start Time/End Time. Start and End Times represent the times each shift is to begin and end. They can be 
entered or displayed in 24‐hour or 12‐hour AM/PM format as defined in the Current Schedule Format. Note: 
Normally, VSS calculates a 24‐hour shift length for shifts with start and end times that are the same (i.e., 7:00a ‐ 
7:00a). 
However, when the start and end time of a shift is 12:00a ‐ 12:00a, VSS will not calculate hours for the shift. This is 
useful when defining items that do not behave like normal shifts (i.e., Vacations, Locations, etc.). 
Break Length. This is the amount, in hours, of unpaid break for a shift. This amount is subtracted from total shift 
length wherever hours are calculated by VSS. Note: You can use break length to designate “Split‐Shifts” by 
setting break length equal to the gap (time) between two shifts. For example: 

1st Shift  07:00a ‐ 11:00a 
2nd Shift  05:00p ‐ 08:00p 
Total Hours  7.00 
would become... 
Split‐Shift  07:00a ‐ 08:00p 
Break Length  6.00 (time from 11:00a to 05:00p) 
Total Hours  7.00 

If the above method does not produce the desired results, another method for handling “Split‐Shifts” is available 
and described later in this guide. 
Quick Key. Here, you can enter the keystroke that can be used to apply the shift. For example, if you entered 
DAYTIME as the shift descriptor, you can enter a “D” for the quick key. Now, you can assign the shift simply by 
pressing the letter “D” on your keyboard. VSS also allows you to designate Shift‐key combinations. For example, 
if you entered DAYTIME as the shift descriptor, you can enter Shift “D” as the quick key. Now, you can assign the 
shift by holding down the Shift key and pressing the letter “D.” Note: The Legend Report allows you to print 
shifts, explanations, and their associated quick keys. You can print this report and keep it nearby as a quick key 
reference. 
Color. You can set the shift color that appears on the screen by clicking the desired color box at any time while 
entering shift information. Note: If you have a printer that supports color printing, you can elect to have your 
reports printed in color by selecting the Print In Color option. See “Report Setup” for more information. 

4 Click OK. 

DEFINING EXPLANATIONS 

Explanations are commonly used for adding detail to shifts. Since shifts (except OFF) indicate when a person is 
supposed to start and end work, explanations are used to tell someone what he/she will be doing on a particular shift 
or where he/she will be working for a particular shift. For example, if a person is assigned to the Day shift (defined as 8 
a.m. to 5 p.m.), an explanation could indicate a location (i.e. 2nd Floor), assignment (i.e. Training), or job (i.e. 
Customer Service). Explanations are also used to indicate a reason for time‐off (OFF), such as vacation, sick, funeral, 
holiday, etc. 

To Define an Explanation 

1 Select Explanations from the Define menu. VSS displays the Define Explanations window. 
2 Select an explanation in the list box; “undefined” for a new explanation.  
3 Make your selections for: 

Description. An explanation description can contain any text and can be up to 20 characters in length. 
Abbreviation. The explanation abbreviation enables you to create a shorthand designation to be used on reports 
and edit screens where there is not enough room for the full explanation description. An abbreviation can be up to 
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five characters long, but you may want to keep them shorter so they can easily fit on all the schedule formats you 
create. If you are using a format that displays abbreviations instead of full descriptions, you can print the Legend 
Report. The Legend can list all shift and explanation abbreviations along with their associated full descriptions, 
quick keys, etc. 
Quick Key. In this field, you can enter the keystroke that can be used to apply the explanation. For example, if you 
entered VACATION as the explanation descriptor, you can enter a “V” for the quick key. Now, you can apply the 
explanation simply by pressing the letter “V” on your keyboard. VSS also allows you to designate Shift‐key 
combinations. For example, if you entered VACATION as the explanation descriptor, you can enter Shift”V” as the 
quick key. Now, you can apply the explanation by holding down the Shift key and pressing the letter “V.” 
TIP 1: The Legend Report allows you to print shifts, explanations and their associated quick keys. You can print 
this report and keep it nearby as a quick key reference. 
TIP 2: You can also use the Ctrl‐L key sequence to automatically open the explanations dropdown list. You can 
then press the first letter of the explanation on your keyboard to assign it to a day cell. Using this method will 
allow your hands to remain on the keyboard while scheduling. 

4 Click OK. 

DEFINING & SHARING COVERAGE TOTALS 

Before you can use the Coverage Totals feature described later in this guide, you must first tell VSS how many totals 
your schedule needs. 

To Define Coverage Totals 

1 Select Define from the menu bar and select Coverage Totals.  The Define Coverage Totals window is displayed. 
2 In the Visible Coverage Totals box, enter the number of coverage totals you want to display. The maximum 

number you can use is 150; however the schedule displays up to 30 in the screen view. 
3 Click OK. The Coverage Totals worksheet is displayed at the bottom of the schedule worksheet with a scroll bar at 

the left used to find those that are listed but not visible in the current view. 

Note: You can click the Coverage Totals quick‐action button to show or hide your Coverage Totals worksheet, select it 
from the View menu to do the same. 

To Share Coverage Totals 

1 From the View menu, select the schedule view. 
2 Select Coverage Totals from the Define menu. 

Note: All defined coverage totals from any view are included in the Coverage Totals list, which allows you to share 
the coverage totals you define across views. 

3 Use the New and Edit buttons to identify the information required for your Coverage Total. 
4 Enter the number of coverage totals to display in the Visible Coverage Totals box. 
5 Click OK. 

Note: Coverage Totals defined within previous versions of VSS are compatible to share, however the row order 
arrangement may require some adjustments. 

DEFINING EMPLOYEE INFORMATION 

Employee information can be viewed, added, or changed using the Employee Profile window. There are several ways 
you can open this window: 

• Click Add New Employee in the task pane 

• From the menu bar, select Define > New Employee or  Edit > Insert > New Employee 

• Click the Employee Profile quick‐action button 

• Click a blank row or name in the schedule Name column 

To Define or View Employee Information 
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1 Click the General, Position/Skills, or Comments tab. 
2 Add, edit, or delete the employee information as needed.  
3 Click Close to save. 

DEFINING INACTIVE EMPLOYEE PARTITION 

You can use the Inactive Employee Partition to keep track of employees that may be temporarily unavailable to 
schedule, such as for those on seasonal schedules or maternity leave. An inactive symbol appears next to the 
employee name and the rows are grayed to easily identify the status. 

The schedules for inactive employees can be copied with the Copy and Paste and Copy Row functions, as well as Copy 
Multiple and Schedule Multiple features, which also remain active. You could define schedule patterns within inactive 
rows and use the Copy Row function to apply them to employee schedules. 

When you move the employee to the inactive partition, the employee is not displayed as available to schedule and will 
not appear in reports, queries, coverage totals, or exported data. 

Inactive employees do not appear in the Scheduling Assistant. 

To Use the Inactive Employee Partition  

1 In the Define menu, select Inactive Employee Partition. 
2 Click the Enable Inactive Employee Partition. 
3 Enter the row number that indicates where you wish the partition to be‐gin. 
4 Click OK. 

Note: You can move employees to and from the inactive partition using the Move Employee To function in the Edit 
menu. Selecting End of Schedule will place the employee in the Inactive Employee Partition. 

Prepare  Your  Schedule  

This section addresses the remaining features and functions you’ll use to prepare your schedule, such as entering names, 
positions or skills, photos, and reminders. 

ENTERING NAMES 

The first column in the VSS window allows you to enter up to 500 names. This should be the first task you do after 
you’ve created your schedule file. 

To Enter Names in Your Schedule 

1 Click a blank row in the Name column of your schedule worksheet to open the Employee Profile window. 
You can also open the Employee Profile window by clicking Add New Employee in the Task Pane, or by selecting 
Define > New Employee or Edit > Insert > New Employee. 

2 Enter the name you wish to add in the General tab of the Employee Profile window. 
Note: You can also use the import features to add names. Each schedule file may contain up to 500 names. 

TIP1: You can move a name to a different row with the Move Employee to command. Names can be sorted by using 
the view Alphabetically by Name command. 

TIP 2: You can change the label used in the Name column by clicking in the Day Ruler (column headings above the 
schedule worksheet) and entering a different name in the Column Titles text box. Note that program references will 
still refer to this column as "Name."VSS uses proportional fonts; you can enter approximately 35 characters in the 
Name column and 15 characters in the Position column. The maximum number of characters that fit will vary, 
depending on which characters you use and which font you selected to use in your schedule view. You can also expand 
the Name and Position columns up to 99 characters to handle signatures or other write‐in information. 

ENTERING POSITIONS OR SKILLS 

The column next to Names in the VSS window allows you to enter Positions and Skills. 
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To Enter a Position or Skill 

1 Click a blank row in the Name column of your schedule worksheet to open the Employee Profile window. 
You can also open the profile window by clicking Add New Employee in the Task Pane, or by selecting Define > 
New Employee or Edit > Insert > New Employee. 

2 Click the Position/Skills tab and click the New button to add a new position. 
3 Enter the job position (i.e., Sales Rep, Manager, Office Staff, Deputy, etc.). 

Note: You can also use the import feature to add positions. 
4 To enter new skills, click the Edit button and in the Skills and Certifications window add or edit the information as 

needed. You can define up to 500 skills per schedule file. 
Note: If you do not need to view information in this column, the Position column can be removed. See Edit 
Schedule Format for more information. 

TIP 1: Use the Sort by Position command to sort names by position.  

TIP 2: You can change the label used in the Position column by clicking in the Day Ruler (column headings above the 
schedule worksheet) and entering a different label in the Column Titles text box. Note that program references will 
still refer to this column as "Position." 

INCLUDING COMMENTS OR PHOTOS 

The Employee Profile window also holds the Comments and Photo tabs. 

To Include Comments or Photos 

1 Open the Employee Profile window, as needed, to include comments or a photo for the employee record. 
2 Click the Comments tab to include additional notes about the employee. 
3 Click the Photo tab to include a photo in the employee profile. 
4 Close. 

Note: Employee photos can also be included in the Employee Profile staff reports. Select Print to open the report. 

IMPORTING EMPLOYEE INFORMATION 

Use the import feature to add employee profile information for new employees in your schedule, or to make updates 
to existing employee data. VSS will import from CSV or tab delimited TXT file formats. Choose Import from the File 
menu, or click the Import button in the Employee Profile window. 

To Import Employee Information with Employee Profile 

1 Locate the row you wish to add or update employee information. 
2 Open the Employee Profile window by clicking that row. The Employee Profile window is displayed. 
3 Click the Import Employee Profile button. 
4 Click the Open button to locate and open the import file. 
5 Select the file you’re using for the import. 
6 Using the drop down lists at the top of each column, choose the titles for the information you’re importing and 

click the Finish button. 
7 Select the employee(s) to import profile information. 

Note: Carefully review your employee selections since VSS is not able to recognize duplicate entries. 
8 Click the Import button and the profile information will be displayed. 
9 Click Close to exit the Employee Profile window. 

To Import Employee Information from the File Menu 

1 Select Import from the File menu and click the Open button to locate and open the import file. 
2 Select the file you’re using for the import. 
3 Using the drop down lists at the top of each column, choose the titles for the information you’re importing and 

click the Finish button. 
4 Select the employee(s) to import profile information. 
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Note: Carefully review your employee selections since VSS is not able to recognize duplicate entries. 
5 Click the Import button and the profile information will be displayed. 

 

USING DIVIDERS & REQUIREMENT ROWS 

Dividers and Requirement Rows are used to separate names of a schedule into logical divisions that help you track 
schedule assignments by groups, such as positions or staffing requirements.  

Note: When a Sort is performed, names are arranged within their respective groups. 

Dividers. Dividers separate the schedule into logical groups and can be used to make the schedule easier to read. You 
can also use a normal divider to attach various comments to the schedule by typing the comment into the Caption 
section of the Divider Properties window. 

Requirement Rows. VSS allows you to define a special type of divider called a Requirement Row. With this type of 
divider you can assign numeric information to each cell in the divider. This information is typically used to assign daily 
staffing requirements for the various shifts defined in the system. You can then reference this divider in Coverage 
Totals to show the variance between scheduled and required staffing. 

Note: You can enter staffing requirements by typing them directly into the Notes section of the schedule editor, 
pressing the plus/minus keys, or by simply typing the numbers using the numeric keypad on your keyboard and 
pressing enter. If more than one day has the same requirement, you can highlight multiple cells and enter the 
requirements for all at the same time. You can also use the Copy, Paste and Copy Multiple commands to quickly 
define requirements.  

INSERTING A DIVIDER 

Dividers are used to separate the names on the schedule into different groups. They can also be used to keep 
information about shift requirements, or to enter miscellaneous notes on a schedule. 

To Insert a Divider 

1 Move the cursor to the place you would like a divider to be inserted. 
2 Select Insert from the Edit menu and select Divider. The Divider Properties window appears. 
3 Define the attributes you would like to assign to this divider. 

Background Color. Dividers can be assigned background colors. To select a color, simply click on the desired color 
square. Check the Default option if you do not have a color printer or would like VSS to default the setting defined 
under Report Setup. 
Appearance on Reports. This option allows you to define alignment of the Caption text (left, center, right) of the 
divider when it is displayed on a schedule. Note: The alignment option will NOT affect the way the Caption text 
appears on the screen. 
Never show on reports. Select this option if you do not want this divider to appear on a schedule. Selecting this 
option will cause VSS to omit this divider from the Names list box in the File > Print window. 
Page break. Select either Before or After to indicate whether a page break should occur before or after the 
divider when you print reports. 

4 Click OK. 

To Modify Properties of an Existing Divider 

1 Move the cursor to a Divider row. 
2 Click the divider title, or caption, directly under the Name column. 
3 Edit the attributes you would like to change on this divider. 
4 Click OK. 

To Remove a Divider 

1 Move the cursor to a Divider row in the schedule worksheet. 
2 Select Remove Row from the Edit menu. 
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3 Click Yes. 
 

INSERTING A REQUIREMENT ROW 

To Insert a Requirement Row 

1 Select a cell within the worksheet where you would like the requirement row. 
2 Select Requirement Row from the Edit > Insert menu. 
3 Enter the title of the requirement. (i.e. Managers/days) 
4 Make your attribute selections. 
5 Click OK. The new requirement row (divider) is inserted into the schedule. 
6 Click one of the day cells for this divider and enter the staffing requirement for this day. 

USING THE SORT FUNCTION 

The first area at the top of the View menu allows you to control the order of names in the schedule worksheet by 
position and hours scheduled for example, as well as locate a specific name within your schedule. 

Note: Sorting occurs within dividers. For example, if you have set up three groups, or divisions, within your schedule, 
the names in group 1, 2 and 3 are sorted separately, thus keeping the names within the same divisions or groups. 

To Sort by Name 

The View > Sort By > Name command sorts the names on the schedule in alphabetical order. 

To Sort by Position 

The View > Sort By > Position command sorts names on the schedule in alphabetical order by their position. If more 
than one name has the same position, the names are sorted in alphabetical order. 

To Sort by Seniority 

The View > Sort By > Seniority command sorts names on the schedule in alphabetical order by their seniority status. If 
more than one name has the same status, the names are sorted in alphabetical order. 

To Sort by Hours Scheduled 

The View > Sort By > Hours Scheduled command sorts names on the schedule in alphabetical order by number of 
hours scheduled. If more than one name has the same hours scheduled, the names are sorted in alphabetical order. 

To Sort by Desired Hours 

The View > Sort By > Desired Hours command sorts names on the schedule in alphabetical order by the number of 
desired hours. If more than one name has the same number, the names are sorted in alphabetical order. 

FINDING A NAME 

The Find Name function allows you to quickly locate a name in the schedule. 

To Find a Name 

1 Select Find Name from the View menu. 
2 Type in a portion of the name you are looking for, or use the arrows to search through the list of names. 
3 When you locate the desired name, click the Go To button, or press the Enter key. 

More quick methods for accessing the Find Name function 

• Press Ctrl+F. 

• Move the mouse over the Name column heading to display the Find icon, then click the Name column heading. 

• Double‐click any date cell in the schedule. 
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CHANGE THE DAY RULER 

The Day Ruler displays the days of the week and dates for the portion of the schedule that is currently visible. The 
format of the Day Ruler and number of days displayed can be changed by modifying the schedule format.  

To Change the Day Ruler Background Color and the Name and Position Column Titles 

1 Click on the Day Ruler. The program displays the Day Ruler Properties window. 
2 Select a background color or click Default. 
3 Enter the title(s) of the column(s) you wish to use; if you are not going to use the titles Name and Position. 
4 Click OK. 

SETTING REMINDERS 

The Reminders feature is a tool that can help you remember when you have tasks to complete, such as e‐mailing 
schedules, preparing reports, and scheduling time‐off requests. Enter a name and other comments needed to describe 
the reminder, set the date and frequency it should appear, and VSS will display the message in the Reminders list. 

To Set a Reminder 

1 Select Reminders from the View menu, or click the Reminders quick‐action button. 
2 Click the New button. 
3 Enter a description for the reminder in the Subject line. 
4 Enter or select a date for the reminder to be displayed. 
5 Choose a frequency for the reminder, if needed, such as on this day or one week before. 
6 Enter any comments needed to further explain the reminder. 
7 Click OK to save your settings. 
8 Click Close. 

Scheduling Your Staff 

Use the topics in this section to learn the how‐tos of VSS scheduling so you can: 

• Assign shifts 

• Assign several shifts at once 

• Schedule several staff at once 

• Assign split‐shifts and rotating shifts 

• Save time with Quick Shifts 

• Use the Scheduling Assistant tool 

• Copy, rotate, or duplicate schedules  

• Enter time‐off requests 

• Mark on‐call assignments 

• Add explanations and notes 

• Enter Schedule Notes 

• Use the Employee Profile tool 

Before  You  Begin  

There are three important steps before beginning to schedule your staff. Be sure that you have: 

1 Created a new schedule file. 
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2 Defined your shifts and explanations, as needed. 

3 Entered names and positions into your schedule worksheet. 

Note:  The order in which you complete the above tasks is not important. 

Shift  Assignments  

There are several types of shifts you may be using in your schedule, such as split‐shifts or rotating shifts. You may also wish 
to assign explanations with your shift assignments. Review these instructions to learn more about utilizing these and other 
VSS features and tools that help make scheduling easier and save you time. 

ASSIGN SHIFTS 

You can use the Assign Shift quick‐action button to assign or schedule shifts. And, to remove a shift, use the Erase 
Shift quick‐action button also in the tool bar. 

To Assign Shifts 

1 Move the cursor to the name and day where you wish to assign a shift. 

To Select Multiple Days. (1) Using your mouse: left‐click and drag the cursor over the desired days. (2) Using your 
keyboard: hold the Shift key down while using the arrow keys to cursor over the desired days. 

Note: You can use the Go To Date quick‐action button to help locate a specific day in your schedule. 

2 Select a shift from the Shift Selector list box. 

3 Click the Assign Shift button, select Assign Shift from the Edit menu, or using your keyboard, press Ctrl+A. 

Note: If the pattern of shifts you are assigning is the same for many names, you can use the Copy and Paste 
commands to create your schedule even faster. The Assign Shift button can also be used to assign Split‐Shifts. 

Important! Pre‐Assigned Time‐Off. This feature allows you to schedule days off, Time‐Off, before assigning shifts. 
Then, when using the Assign Shift command, VSS will NOT assign shifts for days already assigned Time‐Off. If you 
need to assign Time‐Off to a day that has been previously assigned a shift, you will need to erase the shift first. 

ASSIGN SEVERAL SHIFTS AT ONCE 

If you schedule a large staff, assigning a shift one day at a time could be rather tedious. Follow these easy steps to 
assign several shifts at once. 

To Assign Several Shifts 

1 Locate the person you want to schedule to a shift, and left click the corresponding row and date cell (or day). VSS 
highlights the name in blue for easy identification. 

2 Drag to the right to select as many dates as you want to schedule. VSS highlights the selected days. 

Note: To select more than one cell using the keyboard: highlight the desired cell, hold down the Shift key, and 
press the right arrow key. 

3 Select the desired shift from the Shift Selector list box. 

4 Click the Assign Shift quick‐action button, and the shift is assigned to the selected days. 

5 Select the appropriate explanation to add to the selected shifts, as needed. VSS displays the shift and explanation 
for the name and days you selected. 

SCHEDULE SEVERAL STAFF AT ONCE 

The Schedule Multiple function allows you to assign shifts, explanations and notes to multiple staff at the same time. 
You can even attach a query to this function, which allows you to automatically schedule based upon certain criteria. 
Use the Schedule Multiple function to: 
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• Schedule holidays for all staff or selected group 

• Replace Shifts and Explanations for many staff/days in one operation. 

• Clear/erase large blocks of cells 

• Remove data for staff that have been terminated 

• Assign notations and instructions for your entire staff or selected group 

Note: You may wish to save the current schedule file before you begin experimenting with this function. 

To Schedule Several Staff at Once 

1 Select the Schedule Multiple function from the Edit menu. 

2 Enter the starting date and number of days you wish to schedule in this operation. 

Note: You can also highlight the days you are scheduling before you select the Schedule Multiple feature; then, 
the Start Date and Number of Days boxes are populated with the respective date and days. 

3 If you are not using a query, select the name(s) you wish to schedule in this operation. 

Note: Use the Ctrl key to select more than one name. 

4 If using a query, click the Query button. Select the desired query, or create a new query. 

5 Once a query has been selected, VSS automatically highlights all of the staff that matches the criteria in the 
query; you can refer to Query Selection and Editing for help. 

6 Use the Shift drop‐down box to assign, or change, a shift, time‐off or on‐call status in this operation. You can also 
use the Shift drop‐down list to erase shifts. 

7 Use the Explanation drop‐down list to assign, or change, explanations in this operation. 

8 Use the Notes text box to enter any notes that you want to assign. Mark Erase Notes to remove note entries in 
this operation. 

9 Select Clear cell contents first if you want VSS to clear/erase all information in cells before assigning shifts, 
explanations, or notes. 

10 Click Execute to perform the operation. 

SCHEDULE SPLIT‐SHIFTS 

VSS allows you to schedule two shifts, sometimes referred to as a “Split‐Shift,” to a person on the same day. 

Before VSS can accept the entry of split‐shifts, you need to modify your schedule format to display the additional 
shift(s). If you are using more than one format (i.e., Weekly, Daily, etc.) in the schedule file, make sure you modify all 
schedule formats to allow for split‐shifts. 

To Set Up Split‐Shifts 

1 Select Edit Schedule Format from the View menu. The Edit Schedule Format window appears. 

2 Click an available list box, and select Shift2 in the Cell Contents section. 

3 Click the Tie option, if desired. When the Tie option is selected, VSS puts selected items together on one line in 
the schedule. 

4 Click OK. 

Important! Cell  Contents  &  Tie  Option.  There are many split‐shift options. Select options based on (1) number 
of shifts, (2) number of days in your format view, and (3) the information you want tied together. For example, in a 
one‐week view, you might want to display Shift1 and its start and end time (Shift1+Start1+End1) with Shift2 and its 
start and end time (Shift2+Start2+ End2) on the same line using the Tie option while letting the explanation display on 
its own line below. However, in a 28 Day view, you might want to use abbreviations and display Shift1 (D=Day) tied to 
Shift2 (N=Night) on the first line, and again give the explanation (SS=Split‐Shift) its own line below. Just keep in mind 
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that the features in VSS give you the ability to design your schedule to meet your own personal needs. This guide will 
cover more about customizing the look of your schedule in an upcoming section. 

Once you set up your schedule format(s) to allow for "Split‐Shifts," you can assign two shifts to a person on a single 
day. 

To Assign Split‐Shifts 

1 Highlight the day(s) you wish to assign a shift. 

2 Select the first shift in the Shift Selector. 

3 Click the Assign Shift button to schedule the first shift. 

4 Select the second shift in the Shift Selector. 

5 Click the Assign Shift button to schedule the second shift in the “split‐shift.” 

Note: If the start time of the second shift conflicts with the end time of the first shift, VSS displays a message 
indicating there is a shift assignment conflict. 

ROTATING SCHEDULES 

VSS makes rotating schedules easy! The powerful Copy Multiple wizard lets you copy a schedule pattern, or rotation, 
and place it in future dates without having to manually enter the schedule information additional times. For example, 
if you set up a pattern consisting of weekends off, with alternating Mondays and Wednesdays off, you can copy this 
same pattern to another part of the schedule in seconds. 

Make sure you save your schedule file before attempting to use the Copy Multiple wizard. You may want to set up a 
sample or test file before trying the following procedures.  

In order to use Copy Multiple, you must first enter the schedule information you plan to copy, or rotate, forward into 
your schedule worksheet. Once entered, make note of the starting date and number of days or weeks of schedule 
information you want to copy (or, if possible, just highlight it on‐screen). 

To Rotate Schedules with Copy Multiple 

1 Select the day cells to highlight the rotating schedule you want to copy. 

2 Select Copy Multiple from the Edit menu and VSS starts the Copy Multiple wizard. Click Next to continue. 

3 Enter or select the date you want to begin copying from. 

4 Enter the number of days you want to copy. 

Note: You can select up to 999 days of schedule information using Copy Multiple. 

5 Mark the check boxes for the schedule information you want to copy: Shifts, Explanations, On‐Call, Time‐Off, and 
Notes. Click Next to continue. 

6 In the Names list box, select the name or names you want to copy schedule information for and click Next to 
continue. You can click Select All to select everyone, or Clear All to remove selected names. 

7 In the Target dates to copy to list, select the dates you want to copy the schedule information to. VSS copies the 
schedule information for each target date you select and extends your schedule into the future as far as you 
choose. 

8 Mark the Overwrite existing information option if you want to replace any existing data for the target dates you 
selected. 

Note:  When Overwrite existing information is selected, the new data is copied over any existing data. However, 
this only occurs on the options that have been selected (i.e., shifts, Time‐Off, explanations, etc.). When overwrite 
is turned off, shifts, explanations, notes, etc. will not be copied to the destination date(s) unless the corresponding 
data is also blank. 

9 Click Copy. 
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TIP: If you execute the Copy Multiple command while on a Requirement Row, you can use this command to copy 
large blocks of requirement information far into the future. Requirement rows indicate how many people or hours 
you need by position, shift, department, or location. And, VSS shows you if you have over‐scheduled or under‐
scheduled based on your requirements. This is covered in “Entering Staffing Requirements.” 

QUICK SHIFTS 

When you become familiar with scheduling your staff in VSS, you may find the quick shifts schedule window to be a 
great time saver. Simply double‐click a single cell of the employee for whom you are assigning or editing shift 
information. 

The quick shifts schedule window allows you to: 

• Select a shift 

• Add an explanation 

• Assign On‐Call status 

• Add a note 

USING THE SCHEDULING ASSISTANT 

With the powerful, on‐screen Scheduling Assistant, choosing the right employee to schedule is much easier! You can 
use this tool to view a list of available employees sorted by name, position, or number of hours already scheduled, as 
well as number of desired hours, workload, or date hired. The list is displayed in a floating window that’s easy to see 
while never leaving your main schedule worksheet. The window is dynamically updated each time you click a different 
day cell, providing you with a daily list of available employees. 

The Skill Filter function narrows the employee list to only those employees who meet the skills requirements for the 
positions you are monitoring in the assistant. The drop down list displays the skills or certifications you define when 
setting up employee profiles. 

To Use the Scheduling Assistant 

1 Select a day cell. 

2 Select Scheduling Assistant from the View menu, or click the Scheduling Assistant quick‐action button in the tool 
bar. 

3 View the schedule information VSS displays: 

Name. This column displays the names of employees scheduled for the day cell selected. 
Position. This column displays positions, making the search for available RNs, for example, that much faster. To 
sort this list by position, simply click the column header. 
Week Desired. This column displays the number of scheduled hours the employee wishes to have each week. 
Week Actual. This column displays the number of hours each available employee is already scheduled to work. 
Use this information to help avoid costly overtime scheduling errors. 
% Complete. This column displays the percentage of actual hours scheduled in relationship to desired hours 
scheduled. 
Date Hired. This column displays the date the employee was hired. 

4 To narrow the display of employees, you can use the Skill Filter function. Select a defined filter from the drop 
down list, or click the Edit button to make changes. 

5 Change the sort order of the list at any time by clicking the column heading of your preferred sort order. Arrows 
indicate ascending or descending order for the column. 

6 Set the window Transparency Level by clicking and dragging the indicator. This allows you to keep the Scheduling 
Assistant window open without comprising your full view of the schedule. 

7 Click the check box(es) to make your selections for the employees you want displayed:  
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• List employees within current dividers only 

• Omit employees already scheduled 

8 Assign a shift to an available employee by clicking their name. VSS takes you to the appropriate row in your main 
schedule worksheet. 

9 Click the shift you would like to assign in your Shift Selector, and click the Assign Shift button. 

10 Click Close to exit the Scheduling Assistant. 

Using  the  Copy  &  Paste  Features  

When you assign schedule information, you may need to assign identical information to several other staff and periods in 
your schedule. Instead of making individual changes, you can copy shifts, explanations, and on‐call assignments to 
multiple days in one easy step. 

The Edit menu commands – Cut, Copy, Copy Row, Copy Multiple, Paste, and Paste Selective – allow you to copy schedule 
information to other dates in the schedule worksheet. 

You can also access the Edit shortcut menu by right‐clicking anywhere on the schedule worksheet. 

COPY AND PASTE SCHEDULE INFORMATION 

VSS lets you copy a block of information, and assign that information to several other staff and/or time periods in your 
schedule. 

To Copy and Paste Schedule Information 

1 Click a day in the schedule worksheet that contains the information you want to copy. 

2 Drag the mouse to highlight a block of days. 

3 Select Copy from the Edit menu. 

4 Click the starting cell where you want the information to be copied. 

Note:   Information copied to a selected destination erases all existing data. 

5 Select Paste from the Edit menu.   

COPY AND PASTE SELECTED INFORMATION 

With VSS you can copy a block of information, while only pasting selected details from that block, such as shifts, time‐
off, explanations, notes, or on‐call status, to other areas in the schedule worksheet. Refer to the instructions that 
follow for copy and paste of selected information. 

To Copy and Paste Selected Information 

1 Click a day in the schedule worksheet that contains the starting information you want to copy. 

2 Drag the mouse to highlight a block of days. 

3 Select Copy from the Edit menu. 

4 Click the starting day where you want the information to be copied. 

5 Select Paste Selective from the Edit menu. VSS displays the Selective Paste window. 
Shifts. Select this option if you want to paste shift symbols. 
Time‐Off. Select this option to paste Time‐Off requests. 
Explanations. Select this option to paste explanations. 
Notes. Select this option to paste notes. 
On‐Call. Select this option to paste on‐call status. 

6 Select the information you want to copy by clicking the check boxes. Selected check boxes contain an X; click a 
selected check box to clear it. VSS does not copy information that is not checked. 
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7 Click Overwrite if you want VSS to erase existing data. 

Note: When Overwrite is selected, data is copied over any existing data; however, this will only occur on the 
options that have been selected (i.e., Shifts, Time‐Off, Explanations, etc.). When Overwrite is off, shifts, 
explanations, notes, etc. will not be copied to the destination date(s) unless the corresponding data is blank.  

8 Click OK. 

COPY SCHEDULE PATTERN 

You can use the Copy Pattern function to copy a schedule pattern and paste that pattern into highlighted cells over a 
specified time displayed in your schedule worksheet. For example, you can copy a five‐day schedule pattern, highlight 
the following two weeks displayed in your schedule worksheet, and paste the pattern. VSS applies the entire five‐day 
pattern over the two‐week period that was highlighted. 

To Copy a Schedule Pattern 

1 Highlight the schedule pattern you want to copy, and click the Copy button. 

2 In your schedule worksheet, highlight the period of time you want to apply the schedule pattern to. 

3 Click the Paste button. 

COPY ROW 

In one, single step you can copy schedule rows to set up rotating schedules, schedule patterns, or to set up new 
employees in seconds. 

An example for using this timesaving feature includes copying the schedule details of an existing employee into the 
row of a new employee who will be on the same schedule. 

To Copy a Row 

1 From the Edit menu, select Copy Row. 

2 In the Select Row to Copy drop down list, select the row you want to copy. 

3 Choose each row to copy the schedule information into using the drop down for Select Row(s) to Copy to. 

4 Make Options selections for: 

• Copy Entire Row 

• Start Date 

• Number of Days to Copy 

• End Date 

• Copy from Start Date to End of Schedule File 

5 Mark each check box for the Information to Copy: 

• Shifts 

• Explanations 

• On‐Call 

• Time‐Off 

• Notes 

6 Mark the Overwrite Existing Information check box to replace row information. 

Enter  Time‐Off  &  On‐Call  Shifts  

Sometimes the shifts you schedule are actually employee time away from the job. You can assign time‐off and on‐call 
status using VSS. 
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ENTERING TIME‐OFF 

The Time‐Off command/button is used to schedule days that a person will not, or has not, worked. Time‐Off can be 
used for: 

• Standard Time‐Off 

• Vacations 

• Sick time 

• Temporary leaves of absence 

To Enter Time‐Off 

1 Move the cursor to the name and day you wish to assign Time‐Off.  

To Select Multiple Days. (1) Using your mouse: left‐click and drag the cursor over the desired days. (2) Using your 
keyboard: hold the Shift key down while using the arrow keys to cursor over the desired days. 

2 Click the Time‐Off button or select Time‐Off from the Edit menu. 

Note: You can add an explanation to indicate the reason for Time‐Off. 

Important! Pre‐Assigned Time‐Off. The Time‐Off command will not schedule time‐off for days that have been 
assigned shifts. If you need to assign Time‐Off where a shift is already assigned, you need to erase the shift first. 

MARKING ON‐CALL STATUS 

The On‐Call command/button is used to set or remove On‐Call status. 

To Set On‐Call Status 

1 Click the desired day cell(s). 

To Select Multiple Days. (1) Using your mouse: left‐click and drag the cursor over the desired days. (2) Using your 
keyboard: hold the Shift key down while using the arrow keys to cursor over the desired days. 

2 Click the On‐Call button, or select On‐Call from the Edit menu. 

Shift  Explanations  &  Notes  

You can add explanations and notes to the shifts you assign. Refer to “Defining Explanations” in this guide for information 
on the use of explanations. 

ADDING EXPLANATIONS 

The Explanation Selector is used to add explanations on the schedule. VSS indicates an explanation has been added 
either by listing it directly in the cell, or when space doesn’t permit, with a small blue square in the upper left‐hand 
corner of the cell.  

To Add an Explanation 

1 Move the cursor to the name and day you wish to attach an explanation. 

To Select Multiple Days. (1) Using your mouse: left‐click and drag the cursor over the desired days. (2) Using your 
keyboard: hold the Shift key down while using the arrow keys to cursor over the desired days. 

2 Click the down arrow on the Explanation Selector and select the appropriate explanation. 

Note:  You can also assign an explanation with a quick key; refer to “Defining Explanations” in this guide. 

TIP: You can also use the Ctrl+L key sequence to automatically open the Explanation Selector drop down list. Then, 
press the first letter of the explanation followed by Enter to assign it to a day cell. Using this method allows your hands 
to remain on the keyboard while scheduling. 

To Add an Explanation to Time‐Off 
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You can attach explanations to days marked with “OFF” or “X” for Time‐Off, indicating why a person is not working, 
such as personal leave, vacation, illness, or other.  

1 Move the cursor to the assigned Time‐Off you wish to attach an explanation. 

To Select Multiple Days. (1) Using your mouse: left‐click and drag the cursor over the desired days. (2) Using your 
keyboard: hold the Shift key down while using the arrow keys to cursor over the desired days. 

2 Click the down arrow on the Explanation Selector and select the appropriate explanation. 

Note:  You can also assign an explanation with a quick key. 

TIP:  You can use the Ctrl+L key sequence to automatically open the Explanation Selector drop down list. Then, press 
the first letter of the explanation followed by Enter to assign it to a day cell. Using this method allows your hands to 
remain on the keyboard while scheduling. 

To Remove an Explanation 

1 Highlight the day(s) containing the explanation you wish to remove. 

To Select Multiple Days. (1) Using your mouse: left‐click and drag the cursor over the desired days. (2) Using your 
keyboard: hold the Shift key down while using the arrow keys to cursor over the desired days. 

2 Click the down arrow on the Explanation Selector. 

3 Click None. 

11 TIP:  You can also use the Ctrl+L key sequence to automatically open the Explanation Selector drop down list. 
Then, press the N key followed by Enter to remove the explanation. Using this method allows your hands to 
remain on the keyboard while scheduling. 

ENTERING NOTES 

Next to the Explanation Selector is an area for entering notes. Use this area to record additional information about a 
person’s shift, time‐off, or other important information. For example, you may want to display the note “Out of office 
all day ‐ offsite meeting.” 

To Enter Notes 

1 Locate the name and select the date cell to which you want to add a note. 

2 Click the notes entry area (or press Ctrl+ N) and enter a comment or note. 

3 Click the Save Note check mark button next to the notes entry area, or press the Enter key to save the notation. 
The schedule worksheet is marked. 

TIP: If necessary, you can also spell check your note by clicking the Spell Check [abc] button to the far right. 

ENTERING SCHEDULE NOTES 

Share notes about the schedule file or worksheet by adding Schedule Notes. You can use these notes to communicate 
with others who have read/write access to the schedule. 

Schedule Notes is ideal for sharing messages such as “I’ve entered all day shift vacation requests received this week. 
Please enter any requests received from the weekend shift before Monday.” Or, “Please review shift assignments 
based on new HR overtime policy going into effect next week.” 

Choose Schedule Notes from the View menu, or click the Schedule Notes quick‐action button. Enter the information 
you wish to communicate and click Save. If you want the notes displayed when the schedule file is next opened, click 
the box at the bottom of the window. 

Store  Employee  Data  

The Employee Profile tool keeps important information just one click away. Use it for storing employee numbers and hire 
dates, position and skill descriptions, even e‐mail addresses and phone numbers. 
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USING THE EMPLOYEE PROFILE 

The Employee Profile displays contact information, such as phone number and e‐mail address, in read‐only format. 
Others can view the information to reach the employee when needed, while hire dates, certifications, and other 
personal information remain secure and hidden from those viewing the read‐only profile. 

With the Employee Profile window, contacting replacements for no‐shows and sick calls is even faster and easier when 
used with the Scheduling Assistant. 

To Enter Employee Profile Information 

Locate a blank row in your schedule and click in the Name column to access the Employee Profile window. Or, you can 
select Employee Profile from the View menu or click the Employee Profile quick‐action button. 

Note: Learn how to import employee profile details with information from CSV and TXT files. 

You can also access the Employee Profile window by clicking the Employee Profile quick‐action button in the tool bar, 
or by double‐clicking the employee row in the Scheduling Assistant. 

General Tab  

1 Click the text boxes accordingly to enter the employee name and employee number. 

Note: To begin adding scheduled hours for an employee, the only required field is Employee Name. Remaining 
information can be added or edited at any time. 

2 Enter or select the employee Hire Date to help track seniority. 

3 Enter the Desired Hours per Week the employee wishes to have scheduled. 

4 Enter the e‐mail address you’ll use to reach the employee. 

5 Click the Contact Information section to enter contact information, such as phone and pager numbers you can use 
to reach the employee. 

Note: Contact information is displayed in tool tips for easy reference. 

6 Click Close or continue to remaining tabs. 

Note: Click the Next button to move to a new row selection without leaving the profile window. 

Position/Skills Tab 

1 Enter or select the employee position title. 

Note: Click the New button to add the position if it is not available in the drop down box. 

2 Enter the employee skill set details. 

3 Click Close or continue to remaining tabs. 

Comments Tab 

1 Enter any additional comments you wish to record for the employee information record, such as birth date, 
address, or scheduling reminders. 

2 Click Close to exit the Employee Profile window, or Next to enter information for the next employee in your 
schedule. 

You can also use the Employee Profile window to: 

• Send an E‐mail to the Employee. (1) Select the employee in your schedule. (2) Click the Employee Profile button 
in the tool bar. (3) Click the E‐mail button to send a message using your default mail program. 

• Print the Profile Contents. (1) Select the employee in your schedule. (2) Click the Employee Profile button in the 
tool bar. (3) Click the Print button to print a copy of the profile contents. 

• Edit or Delete Employee Information. (1) Click the General, Position/Skills, or Comments tab. (2) Make changes 
to the employee information, or click the Delete Employee button to remove the employee from your schedule.  
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Note: Corrections made in the Employee Profile are applied to your master list of e‐mail addresses in File > Properties 
E‐mail and Data Export tabs; and vice versa. There is no need to make corrections in both locations. 

Customizing Schedule Views 

The View menu in VSS provides remarkable program flexibility. Because VSS offers a WYSIWYG (What You See Is What 
You Get) interface, you can customize a schedule worksheet view and print a report that looks incredibly similar to the 
screen you are viewing. In this section you will learn about: 

• Customizing schedule worksheet views 

• Editing what’s displayed in the schedule worksheet cells 

• Viewing a different schedule period 

• Viewing and change reminders 

• Using the Task Pane 

• Changing the Day Ruler properties 

• Highlighting key schedule information 

• Using the Ledger View 

CUSTOMIZING VIEWS USING EDIT SCHEDULE FORMAT  

VSS allows you to view and edit your schedules in up to five different customized formats. You may wish to have views 
that show many days and names on the screen at the same time, in an abbreviated form, or views that show fewer 
days but contain more information in each Day Cell. You can freely switch between views and use the format that best 
helps you perform a task. 

Before you edit a view, you must first make it the current view. To do so, please refer to “Changing the Current View.” 
You can modify one of the existing, pre‐defined views, or create a new Schedule Format using the two “Not Used” 
formats provided. 

The VSS Edit Schedule Format editor allows you to define the: 

• Number of days that will be displayed on the screen 

• Information that will be displayed in a Day Cell 

• Format of the information displayed in a Day Cell 

• Format of the Day Ruler 

• Font used to display information 

• Column width of the Name and Position columns 

To Define Cell Contents 

Select Edit Schedule Format from the View menu. The six drop down lists in the Cell Contents tab, allow you to select 
the information that will be displayed in a day cell.  

Selecting the information to be displayed 

Screen cell icon  Shows the presence of a note, shift, on‐call, or explanation; if these items are not already 
  selected to be shown in the cell. 

Shift1  Name or abbreviation of first shift (i.e., Daytime or “D”). 

Shift2  Name or abbreviation of second shift (i.e., Daytime or “D”); used when scheduling split‐shifts. 

Shift1+2  Name or abbreviation of first and second shift; used when scheduling split‐shifts. 
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Shift1+Start1+End1  First shift plus the start and ending times. 

Shift2+Start2+End2  Second shift plus the start and ending times; used when scheduling split‐shifts. 

Shift1+Explanation  Shift 1 name or abbreviation plus an explanation. 

Shift1+2+Explanation  Shift 1 and 2 name or abbreviation plus an explanation; used when scheduling split‐shifts. 

Start1  The time first shift begins (i.e., 3:00p or 15:00). 

Start2  The time second shift begins (i.e., 3:00p or 15:00); used when scheduling split‐shifts. 

End1  The time first shift ends (i.e., 4:00p or 16:00). 

End2  The time second shift ends (i.e., 4:00p or 16:00); used when scheduling split‐shifts. 

Start1+End1  The starting and ending times for the first shift. 

Start2+End2  The starting and ending times for the second shift; used when scheduling split‐shifts. 

ShiftLen1  The length of first shift (i.e., 7.50 for seven and 1/2 hours). 

ShiftLen2  The length of a shift (i.e., 7.50 for seven and ½ hours); used when scheduling split‐shifts. 

Explanation  Name or abbreviation of an explanation (i.e., Vacation or “V”). 

Note Text  Reserves one line of the day cell for displaying a note. 

Note Text (2 Line)  Reserves two lines of the day cell for displaying a note. 

Note Text (3 Line)  Reserves three lines of the day cell for displaying a note. 

Note Status  Displays note status text or abbreviation (i.e., See Note or “ * “). 

On‐Call Status  Displays on‐call status text or abbreviation (i.e., On‐Call or “ + “). 

Selecting a combination of items 

VSS also includes several combination items allowing you to display more than one item per row with a single entry. 
For example, Shift1+Explanation displays the description for the first shift and explanations on the same row. Or, 
customize combinations using the Tie Option to display items on the same line in a cell. 

Note: Use the second shift items (Shift2, Start2, ShiftLen2, etc.) when you want VSS to allow you to schedule two 
shifts (Split‐Shifts) to a person on the same day. Refer to the Split‐Shifts instructions for more information. 

To Customize a View 

1 Select Open from the File menu. 

2 Select the example file Sample1.vsc and click Open. 

3 Select Save As from the File menu, and save the example file with a different name. 

4 Select 28‐Day view from the View menu. 

5 VSS displays the schedule in a 28‐Day view. In the next steps, you will edit the cell contents for this 28‐Day view. 
These steps also apply for daily, weekly, or other views you choose to edit. 

6 Select Edit Schedule Format (28 Day) from the View menu. 

7 Type a name for the view, or format, you want to create in the text box at the top of the window. For example, 
“Joe’s Custom View” or “Two‐Week View”; whatever you prefer. 

8 In each of the drop‐down lists in Cell Contents, select the options you want displayed in each cell of the schedule 
worksheet. 

9 After selecting your Cell Contents, you can use the Tie Option to identify items you want displayed on the same 
line in a cell. 

10 Click the check boxes next to each drop‐down list to identify the options you want to appear on the screen and on 
reports. 

Note:  The Show on‐screen option affects only those items viewed in the schedule worksheet. The Show on 
Reports option affects only those items printed on reports. 
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11 Click Apply. VSS applies the changes to the schedule worksheet. 

12 At this time, you can view your changes before accepting them. Click OK if the changes are acceptable. If further 
changes are needed, you can make them at this time. Then, either click Apply to view them, or click OK to accept 
them. 

To Show On‐screen or Show on Report 

In some cases, it is not practical to display all information on‐screen in a day cell, even though you would like this 
information to appear on a printed report. Printers, because of their high resolutions, are capable of displaying more 
information on a single sheet of paper than can appear on‐screen at any one time. In addition, a 5‐point font, for 
example, may be hard to read on‐screen yet be completely legible on a printed report. 

The Show on‐screen and Show on Report option boxes, allow you to select which information you require for screen 
editing and which information you need for the printed report.  

CHANGING THE CURRENT VIEW 

VSS allows you to view, edit, and print your schedules in up to five different formats. For example, you may have 
schedule formats that show many names and days on the screen at one time in an abbreviated form (i.e., 28‐Day, 42‐
Day), along with other schedule formats (i.e., Daily, Weekly) that show more detail. 

To Change the Current View 

1 Select the View menu. 

2 Click the desired view. VSS switches to the selected view.  

Note:  The name and day(s) that were highlighted before switching views appear in the upper left‐hand corner of 
the schedule. A checkmark is placed next to the selected schedule format in the View menu. The name of the 
format also appears in the title area of the VSS main screen. 

VIEWING OR CHANGING REMINDERS 

You can view or change your reminders at any time. You can also sort your reminders by status, date, or subject. A 
status bar at the bottom of the window gives you a quick look at your number of unviewed reminders and four icons 
help you determine the status of each reminder that appears in the list. 

Four symbols are used to indicate: 

• a past due reminder that has not been viewed. 

• a past due reminder that was viewed. 

• an upcoming reminder. 

• an upcoming recurrent reminder. 

To View or Change a Reminder 

1 Select Reminders from the View menu, or click the Reminders quick‐action button in the tool bar. VSS displays 
the list of reminders. 

2 Select the reminder you want to view from the reminder list. 

3 Click the View/Edit button to see the reminder details. 

4 If you no longer need to view this reminder, mark the Viewed check box or click the Delete button to completely 
remove the reminder from the list. 

5 If you need to change the reminder, update the reminder settings and click OK to save your changes. 

6 Click Close. 

VIEWING THE TASK PANE 
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You can further customize your view by turning the Task Pane on or off at any time. 

To Use the Task Pane 

1 Select Task Pane 
from the View menu, or click the Task Pane quick‐action button in the tool bar.   

2 If the Task Pane was visible in your screen view, this selection will then hide the Task Pane, and vice versa. 

CUSTOMIZING VIEW PROPERTIES 

Schedule Format properties allow you to change the way information is displayed in day cells, the Day Ruler, and 
Coverage Watch total areas.  

To Customize View Properties 

1 Access the Properties tab by selecting Edit Schedule Format in the View menu. 

2 Click the Properties tab. 

3 Make your selections. 

Use Abbreviations. When you define shifts and explanations, you can enter a full description and an abbreviated 
description. Selecting this option instructs VSS to substitute abbreviations for full descriptions. For example: 

D instead of Daytime 

Vac instead of Vacation 

Show Time‐Off. Normally, you will want the system to automatically display scheduled Off status, [OFF] or [X], 
and should leave this option selected to utilize all VSS’s capabilities.  If you elect not to have the system display 
scheduled Off status, deselect this option. 

Time Format. Use this option to change the way timed information, such as Start Time and End Time, appear in a 
day cell. This option is also used to determine the default time format of Start and End times while defining shifts. 

Hide Position Column. You can temporarily hide the Position column to free up more space on the screen. 
However, if your scheduling file does not require a Position column, you can elect to turn this feature off by 
deselecting this option.  

Ruler Format (Day). This option allows you to change the way the days of the week are displayed in the Day 
Ruler. Settings for this option depend largely upon the number of days being viewed on‐screen. 

Ruler Format (Date). This option allows you to change the way the date is displayed in the Day Ruler. Settings for 
this option depend largely upon the number if days being viewed on‐screen. 

Days On‐screen. This option allows you to select the number of days that will be displayed on‐screen at any one 
time. You can enter any value between 1 and 42 days. 

Visible Coverage Totals. This option changes the number of coverage watch total lines that appear at the bottom 
of the screen and at the end of printed reports. Lowering this value will not erase any Coverage Watch totals you 
have previously defined; however, they will not be visible. To return them to view, simply scroll up or down within 
the coverage totals. Also, if you have a slower computer system, you can lower this value to increase the overall 
performance of the system. If you have not used all Schedule Formats, you may also wish to create an identical 
format that does not display any Coverage Watch totals to work in when Coverage Watch totals are not needed. 

Name Column Width. This option allows you to increase or decrease the size of the Name column. Maximum 
number of characters is 35. You can expand the Name column up to 99 characters to handle signatures or other 
write‐in information. The number of actual characters that can be viewed varies depending on the font selected. 
Reducing the column width allows you to view more of the main schedule. 

Position Column Width. This option allows you to increase or decrease the size of the Position column. Maximum 
number of characters is 15. You can expand the Position column up to 99 characters to handle signatures or other 
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write‐in information. The number of actual characters that can be viewed varies depending on the font selected. 
Reducing the column width allows you to view more of the main schedule. 

Screen Font. This option allows you to change the Font/Font Size that VSS will be used to display information. 
You can use “Small Fonts” to display more information on the screen. VSS automatically maps the fonts “MS Sans 
Serif” and “Small Fonts” to the TrueType font “Arial” when printing reports. 

4 Click Apply to view the settings. 

5 Click OK to accept. 

CUSTOMIZING YOUR DAY RULER 

The Day Ruler displays the days of the week and dates for the portion of the schedule that is currently visible. The 
format of the Day Ruler and number of days displayed can be changed by modifying the schedule format.  

To Change the Day Ruler Background Color and the Name and Position Column Titles 

1 Click on the Day Ruler. The program displays the Day Ruler Properties window. 

2 Select a background color by clicking the color square you prefer, or click Default for the default settings. 

3 Enter the title(s) of the column(s) you wish to use if you are not going to use the titles Name and Position. 

4 Click OK. 

CHANGING PAGES IN YOUR SCHEDULE 

There are three tools to help you quickly move through your schedule dates. 

• The Go To Date button allows you to quickly move to any date in the schedule file. 

• The Move Backward and Move Forward buttons go back or forward one day, or one page, at a time in the 
schedule file. 

• The on‐screen calendar in the Task Pane lets you locate the date you want and display it in your schedule 
worksheet by selecting it. 

To Go to a Date 

1 Click the Go To Date button. 

2 Enter or select the date you wish to have in your schedule view. 

3 Click Go To.   

USING THE HIGHLIGHTER 

With the highlighter tool, you can easily identify day cells that match the criteria defined by a query. (Queries are 
addressed in “Setting up and Printing Queries”.) For example, quickly identify employees assigned to work a particular 
shift by highlighting desired rows instead of scanning all rows individually within your schedule worksheet. 

An orange box around the highlighter icon indicates it is active. 

To Highlight Day Cells 

1 Select Highlighter from the View menu, or click the Highlighter quick‐action button, and the Highlighter Pens 
window is displayed.  

2 Set highlights for select – or all – colors, by clicking the Edit button and choosing the desired Query (or Queries), 
i.e. [Mangers ‐ Night], [Supervisors ‐ Eves], or whichever query contains the information you want to highlight. 
Note: Click the Edit button to make changes to a query, if needed. 

3 Click OK. The Highlighter will highlight all employee schedules that match the query criteria you selected. 

To Remove Highlights from Cells 
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1 Click the Highlighter button. 

2 Select None from the query drop down list. 

3 Click OK. 

SETTING A LEDGER VIEW 

The Ledger View, which looks similar to a checkbook ledger, allows you to navigate schedules more quickly and easily. 
When your schedule is in ledger view, note that every other line has a color background. You can choose from six 
different color schemes.  

Note:  The Ledger View is used as an on‐screen guide only. It does not appear on printed schedules or reports. 

To Set Ledger View  

1 Select Ledger View from the View menu. 

2 Select one of six different color schemes: Desert, Rose, Lilac, Sky, Cloud, or Spruce. 

Making Schedule Changes 

Invariably, you will have to make changes to schedules. VSS provides you a variety of functions to help simplify the task 
and reduce your chance for mistakes. In this section you will learn how to: 

• Erase shifts and time‐off 

• Clear an entire row of schedule information 

• Insert, move, or remove employees within your schedule 

• Add or delete rows 

• Move schedule information and coverage totals 

ERASING SHIFTS & TIME‐OFF 

You can use the Erase quick‐action button remove either shifts or scheduled time‐off without deleting notes or 
explanations. 

To Erase Shifts and Time‐Off 

1 Click to select a cell, or click and drag to select a range of cells, you would like to erase. 

2 Click the Erase Shift quick‐action button in the tool bar. 

Note: If you make a mistake, use the Undo command from the Edit menu. However, the Undo command only works 
when performed directly after the Erase command. Use the Clear command if you want to remove all schedule 
information in a cell. 

INSERTING A NEW EMPLOYEE 

This command inserts a new employee by adding a row at the current cursor position and pushing all remaining 
information below it. You can also use the import feature to bring new employees into your schedule. 

To Insert a New Employee 

1 Click to position the cursor on the row where you would like the new row inserted. The Employee Profile window 
opens. 

2 Select New Employee from the Define menu and a blank row appears in your schedule. 

3 Enter all necessary Employee Profile information and select Close to save the employee and information added. 
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MOVE EMPLOYEE TO 

This command is used to move employees from one divider to another, such as from supervisors to managers. 

To Move an Employee to a New Location 

1 Move the cursor to the row that contains the name/schedule you wish to move. 

2 Click to select the row. 

3 Select Move Employee to from the Edit menu. 

4 Select the divider you wish to have the employee row appear in. 

5 Click OK. 

REMOVING AN EMPLOYEE ROW 

Use the Remove Row or Remove This Employee commands to remove the employee row identified at the current 
cursor position, and push all remaining information up one row. 

To Remove an Employee Row 

1 Click to position the cursor on the row where you would like the employee removed. 

2 Select Remove Row from the Edit menu, or click the Remove This Employee button in the Employee Profile 
window. 

Note: You can also use these commands to remove incomplete rows from the schedule. 

MOVING NAMES & SCHEDULE INFORMATION 

Use the Employee Profile window to move employee names and schedule information within your schedule. 

To Move Names and Schedule Information 

1 Move the cursor to the row that contains the name/schedule you wish to move. 

2 Click in the name column to select the row. 

3 In the Employee Profile window, use the Move This Employee Up One Row or Move This Employee Down One 
Row buttons until you reach the desired new location. 

4 Click Close to save your changes. 

MOVING COVERAGE TOTAL ROWS 

You can re‐arrange the order of the rows in the Coverage Totals worksheet at any time. 

To Move Coverage Total Rows 

1 Select Coverage Totals from the Define menu. 

2 Select the name of the Coverage Totals row you want to move. 

3 Click the Move Up or Move Down buttons until the row is displayed in the new location within the list. 

4 Click Close to save the change and the row will be displayed in its new location in the Coverage Totals worksheet. 

REMOVING STAFF FROM THE SCHEDULE 

To remove or delete staff names use the Remove Row command or the Remove This Employee button in the 
Employee Profile window. 

For temporary or seasonal employees, you may want to consider moving them to the Inactive Employee Partition. 

REMOVING SCHEDULE INFORMATION 
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Use the Clear command to remove all the contents of a cell, or range of cells. 

To Clear Cell Contents 

1 Click to select a cell, or click and drag to select a range of cells, you would like to clear. 

2 Select Clear from the Edit menu. 

Note: After data has been cleared, it can be restored with the Undo command. The Undo command only works if 
performed directly after the Clear command. To remove only shift letters or time‐off marks, use the Erase Shift 
button. 

ADDING & DELETING ROWS 

Use the Insert Row and Remove Row commands to add or delete rows at the current cursor position. When you insert 
a new row, your existing information is shifted below the new row. When you remove a row, your existing information 
is shifted up one row. 

To Insert a Row 

1 Click to position the cursor on the row where you would like the new row inserted. 

2 Select Insert from the Edit menu, and select Row. 

Note: This command is useful in adding new staff to a group or section of the schedule.  

To Remove a Row 

1 Click to position the cursor on the row where you would like the row removed. 

2 Select Remove Row from the Edit menu. 

Note: You can use this command to remove staff from the schedule. 

USING UNDO 

The Undo command (when available) allows you to cancel the previous edit operation and return the schedule to its 
original contents. For example, if you accidentally copy over a section of the schedule, you can use the Undo 
command to bring back the information you copied over. 

Note: You can only use the Undo command immediately following the undesired edit. Otherwise, the message “Can’t 
Undo” appears in the Edit menu.  

Important! Saving Your Schedule File. It is recommended you save important schedule files as different names 
before you start editing. By doing this, you will always have a copy of the original in case you need it. 

USING CUT, COPY, & PASTE 

You can find cut, copy, and paste commands in the Edit menu, which can also be accessed by right clicking anywhere 
on the main schedule worksheet.  

To Cut 

Select Cut from the Edit menu to remove selected information from the schedule.  

Once data has been cut, it can be pasted to another section of the schedule. You can paste the information as many 
times as you would like.  

You can also remove information by clicking the Cut quick‐action button or pressing Ctrl+X. 

Note: You can also cut data from one schedule file and paste it to another file. 

To Copy 

Select Copy from the Edit menu to copy selected information in the schedule.  
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Once data has been copied, it can be pasted to another section of the schedule. You can paste the information as 
many times as you would like. 

Note: You can also use the Copy function to copy information contained in Requirement Rows too. 

To Paste 

Select Paste from the Edit menu to place data into your schedule after it has been cut or copied elsewhere in the 
schedule. 

You can also paste data by clicking the Paste quick‐action button or pressing Ctrl+V. 

Note: To paste specific data elements, such as shifts, explanations, etc., use the Paste Selective command. The Paste 
command can also be used to place Requirement Row information. 

EXTENDING THE DATES OF YOUR SCHEDULE 

After setting up the starting and ending dates of your schedule file, you may need to expand your schedule file to pre‐
schedule shifts or time‐off requests. 

To Extend Your Schedule File 

1 Select Properties from the File menu. VSS displays the File Properties window. 

2 Click the calendar to select the new File Ending Date, or type the date in the File Ending Date box. 

3 Click OK. 

Note: If you try to scroll beyond the ending date, VSS displays a message asking you if you want to add more days to 
the schedule. 

EDITING NOTE TEXT 

To Edit Note Text 

1 Select the cell requiring note edits. 

2 Click the Note Text Box and edit the notation. Notes can contain up to 60 characters per cell. 

3 Press the Enter key, or click on the Note Save [check mark] button to save. 

4 Click the Spell Check [abc] button to check the spelling of your note. 

Note: Use the Restore Note [arrow] button to restore the note to its previous contents when editing its contents. 

Making Sure Enough People are Scheduled 

VSS lets you schedule your staff quickly and easily while making sure you have the right people scheduled at the right 
place and time. This section covers the topics you’ll want to use to make sure you have scheduled enough people. You will 
learn how to: 

• Enter staffing requirements 

• Use and view Coverage Totals 

• Use the Hourly Coverage tool 

• Calculate staffing variances (what you have versus what you need) 

• View Day Watch 

Coverage  Totals  

The Coverage Totals feature of VSS can display the number of people scheduled by position, shift, and explanation (i.e. 
department, location, job, etc.). It can also track the number of hours scheduled by the same information. 
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The Coverage Total feature goes through each day in the schedule and counts the number of matches to the specific 
criteria that you define. Click the Coverage Total quick‐action button to show or hide this information at any time. 

For example, monitor the Day shift in the Office and these Coverage Total results are displayed in rows and columns below 
the schedule worksheet. Other examples may require you to calculate how many maintenance personnel are scheduled 
the afternoon and evening shifts, how many medical assistants are on‐call, or how many hours you have scheduled by 
shift, department, or other. 

ENTERING STAFFING REQUIREMENTS 

With VSS, you can indicate how many people or hours you need by position, shift, department, or location. And, VSS 
shows you if you have over‐scheduled or under‐scheduled based on your requirements. 

If your staffing level is based upon external variables (i.e. patients, packages, units, etc.), you can use VSS to perform 
staffing calculations. For example, if you schedule nurses based upon patients per hour, or acuity, VSS will help ensure 
you have enough people scheduled to meet your targeted level of care. If you schedule warehouse staff based upon 
the number of packages you expect to ship on any given day, you can enter your projected number of packages into 
VSS and see how many packages/hour your staff must ship to meet your projection. 

Whatever your staffing requirements, VSS can handle them. All you need to do is insert a Requirement Row into the 
schedule worksheet and enter your staffing needs. A Requirement Row looks very similar to a divider – only it has 
numbers in it! 

To Insert a Requirement Row 

1 Click on any date cell in the schedule worksheet where you would like to insert the Requirement Row. 

2 Select Insert from the Edit menu and select Requirement. VSS displays the Requirement Properties window. 

3 Enter a label for the row in the Requirement Title box. For example, enter: Sups/Req/Days to identify the row as 
the required number of supervisors that should be scheduled the day shift. 

4 Define the attributes you would like to assign to this requirement row. 
Background Color. Requirement rows can be assigned background colors. To select a color, simply click on the 
desired color square. Check the Default option if you do not have a color printer or would like VSS to default the 
setting defined under Report Setup. 
Appearance on Reports. This option allows you to define alignment of the Caption text (left, center, right) of the 
requirement row when it is displayed on a schedule. 
Note: The alignment option will NOT affect the way the Caption text appears on the screen. 
Never show on reports. Select this option if you do not want this requirement row to appear on a schedule. 
Selecting this option will cause VSS to omit this requirement row from the Names list box in the File > Print 
window. 
Page break. Select either Before or After to indicate whether a page break should occur before or after the 
divider when you print reports. 

5 Click OK. The Requirement Row is inserted into your schedule containing only the title. It’s now ready for you to 
enter a value for each day, or cell. 

6 Click any day cell within the Requirement Row you added to your schedule. 

7 Enter a number that corresponds to the required daily staffing need, or click the up and down arrow buttons, 
located at the far right of the Value field, to increase or decrease the number displayed in the cell. 

Note: Use this same procedure to make changes, or edit, your requirement rows, as needed. 

USING COVERAGE TOTALS 

The Coverage Totals feature can calculate scheduling data automatically and display this information in an easy‐to‐
use table at the bottom of the schedule worksheet. You can define up to 150 Coverage Watch totals in each of the five 
schedule formats. Coverage Totals, for example, can: 
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• Calculate the number of maintenance personnel working the afternoon and evening shifts. 

• Calculate the number of medical assistants who have been scheduled Time‐Off. 

• Calculate differences (variances) from what is required and what is actually scheduled. 

Note: Before you can define a coverage total, you must first tell the system how many totals you need. For more 
information, see “Defining & Sharing Coverage Totals.” 

To Use Coverage Totals 

1 Click the title area (first column) of the desired row in the Coverage Totals worksheet, or select Coverage Totals 
from the Define menu. VSS displays the Define Coverage Totals window. 

2 Click the New button. 

3 In the Title box, enter the title (up to 20 characters) that best describes the total you are about to set up. For 
example: 

• Managers on Nights 

• Clerks that are OFF 

• Available Techs 

4 Choose your options in each tab. 

Names Tab 

The Names tab is used to designate which names should be included in the total. You can build a coverage total 
that includes all names, names by position, or hand pick individual names from the list. 
Ignore Name Checking. When you check this option, you are telling the system that all names should be used in 
this coverage total (everybody). If the coverage total is for a select group of names, positions, or individuals, you 
should uncheck this option. 
Check by Position. If the coverage total is for a particular position (i.e., Nurse, Manager, Office Staff, etc.), you 
should check this option and select the appropriate position. You may also check more than one position by 
holding down the Ctrl key while selecting multiple positions randomly. 
Selecting Individual Names. Sometimes you may want to define a coverage total for a single name or group of 
names that work more than one position. (1) Make sure the Ignore Name Checking and Check by Position options 
are not selected; and (2) Select the individual name or names in the Names list box. Multiple names may be 
selected by holding the mouse button down while moving up or down. To select multiple names at random, hold 
the Ctrl key down while clicking selections. 

Skills Tab 

Use this tab to designate the skills, or certifications, to be included. 

Explanations Tab 

The Explanations tab is used to designate which explanations, if any, should be included in the Coverage Totals 
worksheet. Click the Explanations tab to designate the explanations you want to use. 
Selecting Explanations. (1) make sure the Ignore Explanation Checking option is not selected; and (2) select an 
explanation, or group of explanations, in the Explanations drop‐down list. Multiple explanations are selected by 
holding the mouse button down while moving up or down. Or, select randomly by holding the Ctrl key while 
clicking selections. 
Ignore Explanation Checking. Select this option if explanations are not to be considered.  

Shifts Tab 

The Shifts tab is used to designate which shifts, if any, should be included. Click the Shifts tab to designate the 
shifts you want to use. 
Select Shifts. (1) make sure the Ignore Shift Checking option is not selected; and (2) select a shift or group of 
shifts in the Shifts drop‐down list. Multiple shifts may be selected by holding the mouse button down while 
moving up or down. To select multiple shifts at random, hold the Ctrl key down while clicking selections. 
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Ignore Shift Checking. Select this option if shifts are not to be considered. 
Not Scheduled. VSS considers a day cell that has not been assigned a shift, or has not been scheduled Off to be 
“Not Scheduled.” The “Not Scheduled” option can be useful for determining when people are available. Attached 
explanations and notes do not affect the “Not Scheduled” status of a day cell. 
Off. Use this item to track Scheduled Off status. 
On‐Call. Use this item to track On‐Call status. 

Variance Tab 

The Variance tab is used to determine the output style of the Coverage Totals. You can select the desired numeric 
format and link a Requirement Row. 
Requirement.  VSS allows you to maintain shift requirement information directly in the main schedule. These 
requirements can then be referenced by a coverage total to show the variance between the number of shifts 
scheduled and shifts required. Before you can use this feature, you will have to define shift requirements by 
setting up a Requirement Row. The titles for all Requirement Rows defined appear in the Requirement dropdown 
list. Select the Requirement Row that corresponds to the coverage total. VSS displays negative (under‐ 
scheduled) values in red and positive (over‐scheduled) values in black. All Coverage Totals cells that exactly match 
the corresponding requirement for that day will be blank or empty. 
Operation. From the Operation drop‐down list, select one of eight operations from which to add, subtract, 
multiply or divide coverage total lines and requirements. Operations you can select include (where C = Coverage 
Totals line and R = Requirement): 

Variance (C ‐ R)  Ratio (C / R) 
Variance (R ‐ C)  Ratio (R / C) 
Sum (C + R)  Percent (C x 100 / R) 
Product (C x R)  Percent (R x 100 / C) 

For example, Variance (C ‐ R) will calculate the difference between the actual Coverage and what is Required 
(as indicated in the Requirement Row). 

Format Tab 

The Format tab is used to set up a coverage total displayed as a count, by the total number of matches per day, or 
as an accumulation of hours for all of the shifts that match the coverage total for a day. You can also make your 
color selections. 
Standard Count (Default). Use this setting to track the total number of people that match the coverage total 
query. You should always select Standard Count for coverage totals that are NOT tracking shift hours. 
Hours (9999.99 ‐ 9999). Use this setting to track the total number of “man”‐hours scheduled for all people that 
match the coverage total query. Coverage totals that use the hours format are excluded in hours and hundredths 
of hours. For example, one hour and thirty minutes would be excluded as (1.5) hours. 
Color Properties. Click this button to modify the background color for this coverage total. 

5 Click OK. 

6 Click Close. 

PRINTING COVERAGE TOTALS 

VSS gives you the ability to print your coverage watch totals without printing an entire schedule worksheet. This 
important information can be shared with others, giving them a staffing snapshot without searching through the 
schedule. 

To Print Coverage Totals Only 

1 Select your current view from the Reports menu. 

2 Make no name selections in the Names list box; click the Clear All button, if needed. 

3 Click the Print or Preview button. 

FINDING TOTAL HOURS 
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A number of cell indicators show current information about the day(s) you have highlighted. The last box at the right 
indicates the length, in hours, of any shift assigned to the active cell. If more than one cell is active, the Total Hours 
indicator displays the total hours for all of the cells. 

Note: Break length is subtracted from the value shown in the Total Hours indicator. 

VIEWING HOURLY COVERAGE 

The Hourly Coverage feature allows you to quickly view shift coverage by hour, half‐hour, or quarter‐hour time 
increments without leaving the main schedule worksheet. In this floating window, you can obtain a detailed, on‐
screen listing of which names are scheduled for a particular hour, view coverage graphs by position, and even see your 
coverages dynamically updated as you make changes to your schedule worksheet. 

To View Hourly Shift Coverage 

1 Select Hourly Coverage from the View menu, or click the Hourly Coverage quick‐action button located in the tool 
bar. 

2 Click a column header, and select a query from the Select Query window. You can also click New to define a new 
query, or Edit to change an existing query. 

Here, you’re identifying the query that will be used to track hourly coverage for this column. VSS allows you track 
up to 10 columns of hourly coverage information. 

TIP: As a general rule, when defining your query, you should select all shifts (day, evening, night, etc.). If you 
don’t, the values for hourly coverage could be inaccurate. 

3 Choose the desired time increment by clicking the drop down arrow, and selecting 1‐hour, 30‐minute or 15‐
minute. 

Note: You can switch to another time increment at any time while viewing hourly coverage. 

4 Choose the Hourly Coverage features by clicking the appropriate button. 
Graph. In this view, hourly coverages are displayed in a graph format. 
Details. Select a cell, and use this view to see a detailed list of names and schedule information for those 
scheduled during that period. 
Report Setup. Here, make your General, Paper/Margins, and Color/Shading selections before printing reports. 
Print. Print without having to exit the Hourly Coverage window. 
Preview. Preview before sending the report to your printer. Functions from this window include Publish, E‐mail, 
and Print. 

5 Click Close to exit. 

VIEWING DAY WATCH 

When you open the Day Watch view at the bottom of your schedule worksheet, a bar chart illustrates the number of 
employees you have assigned for each hour of the day you select. You can sort employees in this view by skill, or 
group of skills, and view all or view within a divider. 

To open or close this view, choose Day Watch from the View menu, or click the Day Watch quick‐action button. Select 
the day by clicking day cells in your schedule worksheet. 

Note: To modify skill filters in Day Watch, click the Edit button. 

Staffing  Variances  

Besides the previous examples, Coverage Totals can calculate differences (or variances) in what is required and what is 
actually scheduled. For example, a negative number (i.e. –1) shows the number of Managers scheduled to work the Day 
shift, versus what is required, is one short. In order to use this coverage feature, a Requirement Row that indicates the 
necessary number of day shifts for Managers is inserted in the worksheet. The difference between what is required and the 
actual number of Managers scheduled the Day shift is the variance displayed. 

44  Visual Staff Scheduler 

 



Review the remaining topics in this section to learn how to set up Coverage Totals and Requirement Rows, and calculate 
variances, percentages, and ratios based on your staffing requirements. 

CALCULATING STAFFING VARIANCES 

You can link the numbers you entered into Requirement Rows with Coverage Watch values to perform staffing 
calculations. Requirement Row and Coverage Watch values can be added, subtracted, multiplied, or divided, and used 
to calculate percentages. 

You can practice these calculation steps in the Service Department.vsc file to track the number of supervisors 
scheduled a shift, and then compare what’s scheduled to what’s required. 

To Calculate a Variance 

1 Click a blank line in the Coverage Totals table. The program displays the Define Coverage Totals window. 

2 Enter “Sups/Days/Variance” in the Title box. 

3 Click the Names tab. 

4 Unmark Ignore Name Checking, mark Check by Position, and select Supervisor. 

5 Click the Shifts tab. 

6 Unmark Ignore Shift Checking and select Day. 

7 Click the Variance tab and select the options: 

Requirement: Sups/Req/Days 

Operation: Variance (C‐R)  

Note: “Operation: Variance (C‐R)” calculates the difference between what is the actual coverage and what is 
required, as indicated in the Requirement Row. 

8 Click the Format tab and select Standard count. 

9 Click OK. VSS displays the variance in the Coverage Totals table. 

Setting up & Printing Queries 

Query functions in VSS allow you to make lists, filter out information, and gather and print specific information from all the 
data in your schedule file. This section covers the how‐tos for: 

• Creating and editing queries 

• Selecting and running queries 

• Setting up a query report for selected schedule information 

• Printing a query report 

• Using a query to find names 

What  is  a  Query?  

Simply put, a query is a question about the information in your schedule. Queries check each cell, from the specified start 
date to the end date, to see if there are any matches for the criteria (questions) you specify. If matches are found, VSS 
displays a window with the names and the number of matches. 

Queries are defined in much the same way as Coverage Totals. Popular examples of queries include vacation, tardy and 
sick day reports. Queries can also be used to filter schedules or reports, such as by position, shift, department, or job. 
Queries are also used in conjunction with the Find Name function to locate specific individuals (i.e. available Managers, 
etc.) 
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How  to  Use  Queries  

Queries are used throughout VSS as an easy way of selecting, highlighting, or printing the right information for a particular 
task. You can use queries in the: 

• Highlighter 

• Query report 

• Staff Schedules 

• Schedule Reports 

• Find Name 

• Hourly Coverage 

• Schedule Multiple 

CREATING A NEW QUERY OR EDITING AN EXISTING ONE 

Query functions allow you to make lists, filter out information, and gather and print specific details from all the 
information in your schedule file. You can create new queries as needed, or make changes to existing queries. 

To Create or Edit a Query 

1 Select Query from the Reports menu. VSS displays the Query window. 
2 To define a new query, click New. VSS locates the first available undefined query and displays the Edit Query 

window. 
Note: The first query, “Notes,” is pre‐defined by the system and cannot be changed. You should run the “Notes” 
query report anytime you print a schedule that uses Note Status, for example. 

3 To edit an existing query, select the query in the Query Name drop‐down list. Then, click Edit to display the Edit 
Query window. 

4 Make your query selections. 

  Names Tab 

The Names tab is used to designate which names should be included in the query. You can build a query that will 
include all names, names by position, or hand pick individual names from the Names list. To edit the Names 
section of the query, click the Names tab of the Edit Query window. 

Ignore Name Checking. When you select this option, you are telling the system that all names should pass 
this portion of the query (everybody). If the query is to be for a select group of names, position, or individual, 
you should deselect this option. 
Check by Position. If the query is for a particular position (i.e., Nurse, Deputy, etc.) you should check this 
option, and then select the appropriate position or positions by pressing the Ctrl key and selecting multiple 
positions randomly. 
Selecting Individual Names. Sometimes you may want to build a query for a single name, or group of names, 
that work more than one position. 
To do so, (1) make sure the Ignore Name Checking and Check by Position options are not selected; and (2) 
select the individual name, or names, in the Names list box. 
Select multiple names by holding the mouse button down while moving up or down. To select multiple 
names at random, hold the Ctrl key down while making mouse selections. 

  Skills Tab 

Use this tab to designate the skills, or certifications, which should be included. 

  Explanations Tab 

The Explanations tab is used to designate which explanations, if any, should be included in the query. To edit the 
explanations portion of the query, click the Explanations tab of the Edit Query window. 
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Ignore Explanation Checking. You would select this option if explanations are not to be considered in the 
query. 
Selecting Explanations. To make selections, (1) make sure the Ignore Explanation Checking option is not 
selected; and, (2) Select an explanation, or group of explanations, in the Explanations drop down list. 
Select multiple explanations by holding the mouse button down while moving up or down. To select multiple 
explanations at random, hold the Ctrl key down while making mouse selections. 

  Shifts Tab 

The Shifts tab is used to designate which shifts, if any, should be included in the query. To edit the Shifts portion 
of the query, click on the Shifts tab of the Edit Query window. 

Ignore Shift Checking. Select this option if shifts are not to be considered in the query. 
Selecting Shifts. To do so, (1) make sure the Ignore Shift Checking option is not selected; and, (2) select a 
shift, or group of shifts, in the Shifts drop down list. 
Select multiple shifts by holding the mouse button down while moving up or down. To select multiple shifts 
at random, hold the Ctrl key down while making mouse selections. 
Not Scheduled. VSS considers a day cell that has not been assigned a shift, or has not been scheduled Off to 
be “Not Scheduled.” The “Not Scheduled” option can be useful for determining when people are available. 
Attached explanations and notes do not affect the “Not Scheduled” status of a day cell. 
Off. Use this item to track scheduled Off status. 
On‐Call. Use this item to track On‐Call status. 

  Notes Tab 

The Notes tab allows you to design a query that searches for the occurrence of text that appears in a Note field. 
Enter the Note text you wish to include in the query. Or, leave the text box blank to ignore Note text searching. 

5 Click OK. 

RUNNING A QUERY 

A query should be thought of as a question or set of questions you are asking the system about information contained 
in the schedule file. You can set up a Query to ask questions about: 

• Names or Positions 

• Skills 

• On‐Call Status 

• Explanations 

• Time‐Off Status 

• Shifts 

• Notes 

To Run a Query 

1 Select Query from the Reports menu. 
2 Select the desired query from the Query Name drop down list.  

Note: If you have a long list of queries, you can type the first letter of a query name to find the one you’re looking 
for. VSS displays the first query that begins with the letter you typed. Continue pressing the letter until you find 
the one you’re looking for. 

3 Enter the date range you wish the query to cover. Click the calendars to make your selections, or type the dates in 
the Start and End text boxes. 
Note: Click the BOF (beginning of file) or EOF (end of file) buttons to run the query from the first date in schedule 
file to the last date. 

4 Click Run. After a moment, VSS will display the result of the Query. 
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Query  Selection  &  Reporting  

You can quickly locate information in VSS by selecting a query. Also, you can print a report that identifies selected 
information from the schedule. A good example of a common query is a vacation report that lists vacation dates for all 
staff over a selected period of time. 

SELECTING A QUERY 

You can select queries as needed while using VSS. You can also assign a query to the Find Name function which 
instructs VSS to list only those names that match the criteria of the query. 

To Select a Query 

1 Launch the Query window. 
2 Select a query from the Query Name drop‐down list.  
3 If you need to create a new query, click New to locate the next available “undefined” query. To change an existing 

query, click the Edit button. 

To Find Names with a Query 

1 Select Find Name from the View menu, or double‐click any day cell in your schedule worksheet. 
2 Click the Query button to set up the list of names. 

Note: VSS uses the date range defined by the cursor when determining which names match the query. 
3 Make your query selection, and click OK to return to the Find Name window. The list of names includes only those 

that match the query you selected. 
4 Select the name, and click Go To. 

PRINTING QUERY RESULTS 

When VSS displays your query results, you’ll have access to the Print Query window. It displays all names that had at 
least one day match the query for the selected date range. 

To Print a Query Report 

1 In the list, select the names you wish to be on the report, or click the print names only check box if you prefer this 
format. 

2 Enter the number of copies of this report that you would like VSS to print. 

Note: The copies value does not affect the number of pages printed when previewing reports or publishing HTML 
documents. 

3 Click Report Setup to make General and Paper/Margins selections. 

4 Click the Preview button to preview an image of the report before printing, to publish a copy of the report in the 
HTML format, or to e‐mail the report. 

5 Click Print. 

Printing Schedules & Reports 

VSS offers unbeatable flexibility when it comes to printing schedules and reports. The flexible of the VSS printing function 
gives you the ability to create an almost infinite variety of customized output. In this section you will learn how to: 

• Print schedules that show employee numbers, shifts, explanations, notes, and other definitions used in the worksheet 

• Print customized schedules that show only selected positions, shifts, explanations, notes, and other options 

• Print personal schedules for one or more employees 

• Print an estimated cost report that estimates labor costs 
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• Print a blank schedule for scheduling and planning 

• Print a report that shows all the abbreviations, starting and ending times, quick keys, and other options you defined in 
the worksheet 

• Print staff schedules that show selected personnel scheduled for one month or 1 to 42 days 

• Set up and print group schedules 

Printing  Schedules  and  Reports  

In its basic form, printing is closely tied to what is displayed on your screen, using the same parameters defined for viewing 
a schedule worksheet. For example, if you select a seven‐day format to view, you can likewise print a seven‐day report. 
WYSIWYG printing functions can be accessed from the File Menu or the Edit Schedule Format function. In addition, you 
can run special reports from the Reports menu for just about any combination of schedule information. 

PRINT AND PRINT OPTIONS 

The Print command is used to print schedules and reports. You can modify Print Options and Printer settings, as well 
as add a legend to the report or schedule. 

To Print 

Select the File>Print command to print a copy of the schedule that is currently being viewed. 

To Set Print Options 

Print options are accessible by clicking the Print button in the report window and they allow you page range and 
copies to print. 

Note: Other printer options, such as Paper Size and Tray Selection, need to be made in the operating system’s Control 
Panel before entering VSS. 

Range. Enter the range of pages you would like VSS to print. 
Copies. Enter the number of copies you would like VSS to print.  

Note: The Copies value does not affect the number of pages printed when previewing reports or publishing HTML 
documents. 

To Set Up Printer 

Use the Printer Setup command to change the printer that VSS will send reports to. Printer Setup only allows you to 
change the printer, not the settings associated with a particular printer. 

By clicking the Report Setup button before printing a particular report, VSS allows you to select print orientation (i.e., 
Landscape or Portrait) and printer DPI settings for each report.  

You can find the Report Setup button in the windows for the report. 

TIP:  If you have a fax modem, you can fax a VSS report by changing the printer to your fax modem driver. 

To Automatically Add Legends to Schedules 

To add the shifts and explanations at the end of schedules automatically, simply mark the Append Legend check box 
in the Print window. 

When the check box is marked, the legend is added to printed or published schedules. 

SET UP REPORTS 

Report Setup allows you to set the various attributes associated with a printed page. Using Report Setup you can 
define: 

• Report Titles 

• Page Orientation 
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• Print Quality 

• Font Name, Size, Attributes 

• Page Margins and Size 

• Color and Shading  

• Footers 

To change the report settings for a report, click the Report Setup button located on the reports window. 

Note: Although you can access Report Setup from any print/report window, not all options are available for every 
report. 

To Set up Reports 

1 Make your General Report Settings. 
Title. Enter the title you wish to display at the top of the report in the Title Box. 
Orientation. This option controls whether the report will print in Portrait or Landscape. 
Print Quality. Use this option to select the quality of the output desired. If you receive “OUT OF MEMORY” errors 
when printing a report, try selecting a lower print quality setting. 
Footer. Select this option to enter a special message or Note at the bottom of each page in the schedule report. 
When the Schedule Footer dialogue box is displayed, select the General tab, click Enable Footer, and then type 
your Note or message in the text box. You can also use Spell Check to check the spelling of your message. 
Font. If you are printing the current schedule format, you can choose to use the same font that is being used on 
the screen, or select a different printer font. Select the Use Screen Font option to print with the current screen 
font. To select a different printer font, deselect the Use Screen Font option (if available), and click the Font 
button.  You can manually enter font sizes as low as 4 points. 

2 Make your Margins/Paper selections. 
Adjustments. VSS allows you to adjust the Top, Bottom, Left and Right page margins for most reports in the 
system. 
Margins scale. The default scale for margins is inches. Click the Centimeters box if you need margins represented 
in centimeters. 
Paper. You can select the desired Paper Size and Paper Bin. VSS supports paper sizes up to 34” x 44” for larger 
printers or plotters. If you want VSS to print reports with the default value for your printer, these options should 
be set to the Default setting. Note: Most laser and inkjet printers cannot print to the edge of a piece of paper. The 
size of this unprintable area can vary greatly from printer to printer. If you set margins to a value that the printer 
cannot support, VSS adjusts the value to avoid truncating the contents of the report. 

3 Choose your Color/Shading settings. 
Color. Most of the reports you can print with VSS support a color printer. Select the Print In Color option if you 
would like to print your reports in color. Selecting the color option with a non‐color printer may produce distorted 
characters on the report. 
Shading. The Shading options allow you to adjust the gray background that is used in certain areas on some 
reports. Shaded areas are used to help make a report easier to read by highlighting various areas, or dividing 
information into different sections. The appearance of the shaded areas can vary greatly from printer to printer, 
and at different resolutions. You can adjust the darkness level by changing the Shade Percent option. You can also 
turn off shading by deselecting the area. 
Note: Dividers always appear as a shaded row on a report. Additionally, some VSS reports may not support all of 
the color and shading options. 

4 Click Close. 

Reports  Menu  

The Reports menu contains a list of the reports that can be printed. For example, first item on the Reports menu, Current 
Schedule Format, allows you to print the schedule that is currently on‐screen. 

CURRENT SCHEDULE FORMAT 
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The ability to create custom schedule formats is one of the most powerful features of VSS. With this feature, you can 
design and print an almost infinite variety of schedules. 

After you have completed a scheduling session, you can print schedules by selecting Print from the File menu, or 
selecting the name of the Current Schedule Format from the Reports Menu (this will always be the first item on the 
Reports menu). 

Note: When designing a schedule format, you can quickly print a test copy by clicking the Print button located in the 
Edit Schedule Format window. 

The Print function will always produce a schedule based on the current schedule format. If you wish to print a schedule 
in a different style than appears on the screen, you need to first select the appropriate format from the View Menu; 
you can refer to changing the current view. 

Print 

The Print window contains many features that help you customize your schedules even further. 

Names List Box. When you are not using a query, you should use the Names List Box to select the name(s) you would 
like to display on the printed schedule. If you have included dividers in your schedule, they will appear in the Names 
List Box list. You can include dividers in your report by selecting them just as you would any other name in the list. 

1 Click the Select All button to select all names in the list. 
2 Click the Clear All button to deselect all names. 
3 Multiple names may be selected by holding the mouse button down while moving up or down. To select 

multiple names at random, hold the Ctrl key down while making mouse selections. 
Note: You must select at least one name before you can print the report. 

Title. Use the default, or enter your own title. 
Date Range. Normally, you will want the printed report to display the same days that are currently on the screen; 
however, there are cases where this may not produce the results you desire. 

Same as screen 
This option is used when you wish to print a schedule with the same days that are currently on‐screen. 
Current Month 
Select this option if you want the system to print a monthly schedule. Note: Daily, Weekly or similar schedule 
formats may produce reports that are not visually compatible with this option. You may need to change/reduce 
the printer font, switch to landscape, or select a larger paper type when printing more days than a format was 
designed to accommodate. 
Selected 
When you use this option, you are allowed to manually select the Start Date and Number of Days for the printed 
schedule.  
In the main Schedule Editor, the default Start Date and Number of Days can be changed by highlighting the 
desired date range before selecting the print function. 
Subsequent Schedules to Print 
Enter a number here for printing additional schedule information. This will match your selected date range, such 
as subsequent daily, weekly, or monthly schedules. Note: Daily, Weekly or similar schedule formats may produce 
reports that are not visually compatible with this option. You may need to change/reduce the printer font, switch 
to landscape, or select a larger paper type when printing more days than a format was designed to accommodate. 

Name Selection and Ordering. VSS allows you to print reports using the Sort and Query functions. You can use these 
features to print vacation schedules, shift schedules, departmental schedules, and so on. 

Sort 
There are times when you will want the information on the schedule to be sorted, or arranged, in a particular 
order. The most common example is a daily schedule that is sorted by shift start‐time so that people assigned to 
earlier shifts are listed before people that are scheduled later in the day. VSS allows you to sort schedules by up to 
five different types of information: Name, Position, Shift (description), Start Time and Explanation. 
To Sort by Position and Alphabetically by Name:  

1 Click the Sort button. 
2 Select Position for the [1st] key. 
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3 Select Name for the [2nd] key. 
4 All other keys [3rd ‐ 5th] should be set to None. 
5 Click OK. 

VSS does not sort across dividers. All information contained in a divider section remains in that section. If you do 
not want information to remain in the group, or section, defined by a divider you need to select the "Never show 
on reports" option in the Properties window for the divider(s). 
To access the properties for an existing divider: 

1 Click the divider in the area below the Name column to access properties. 
2 Refer to “Insert Divider” as needed for more information about dividers and divider properties. 

Query. VSS allows you to print reports using the Query function. You can use this feature to print vacation schedules, 
shift schedules, departmental schedules, etc. Click the Query button to select a query; refer to query selection and 
editing for additional instructions, if needed.  

Non‐Matching Cells 
In some cases, information on a schedule will not match the criteria defined by a query.  

1 Select Dull if you want non‐matching cells to be dulled. 
2 Select Omit if you do not want information in non‐matching cells to be included in the schedule. 
3 Select Normal if you want information in non‐matching cells to be printed normally.  

Options.  Use these options to further define the format of the schedule you are printing. 
Blank Schedule 
Select this option if you would like the system to print a schedule that contains names, but has no other 
scheduling data on it. The following is a list of some of the ways you might use a blank schedule. 

• Planning a schedule before entering on‐screen 
• Staff self‐scheduling 
• Staff time‐off request sheet 
• Companion hand written information 
• Tracking actual hours 

 
• Tracking tardiness, sick time, etc. 
• Omit Saturdays / Omit Sundays 

Select these options if you are printing a report that is longer than one week and do not schedule personnel for 
Saturdays or Sundays. 
Omit Coverage Totals 
Select this option if you do not want Coverage Totals to display at the bottom of the printed report.  
Highlighter 
Select the Highlighter option to print the highlighter used for selected day cells in the schedule. The highlighter 
allows you to highlight day cells that match the criteria defined by a query; refer to the Highlighter topic for more 
instructions.  
Total Hours Column 
Select this option to add a Total Hours column at the far right side of your report. The Total Hours column totals 
the number of hours each person has been scheduled for the selected date range.  
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Append Legend 
Choose this option to include a Legend page to the end of the schedule or schedules you are printing. 
Print Employee Numbers Only 
Select this option to display employee numbers only and not employee names when printing, publishing, or e‐
mailing staff schedules. 

LEGEND REPORT 

While many of the shifts, explanations, or notes can easily be viewed or printed in a daily or weekly schedule format, 
formats that show more days may require you to substitute abbreviations for full descriptions. Abbreviations allow all 
of the information to fit neatly on‐screen or on a single sheet of paper. 

The Legend function produces a list of shifts, explanations plus associated abbreviations, and can be automatically 
added to your schedules. You should post the Legend next to any schedule that uses abbreviations instead of full 
descriptions. 

To Print a Legend 

1 Click the Reports menu and select Legend. VSS displays the Legend window. 
2 Review the Legend List Box for changes or additions. 

Abbr. This is the abbreviation associated with a particular Shift or Explanation. 
Description. This is the full description of the Shift or Explanation. 
Start/End Time. This is the Start and End time of a Shift.  
Break. This is the non‐paid break length included in a Shift. 
Length. This is the total length of a Shift, minus Break Length. 
Quick Key. This is the Quick Key associated with a Shift or Explanation. 
Note: Start/End time, Break and Length apply only to SHIFTS listed in the Legend list box. 

3 Make your Print Options selections by marking the check box for each item to print in your report: Start/End 
Times, Shift Length, Break Length, Quick Keys, and Separate Shifts & Explanations. 
Separate Shifts and Explanations. If selected, this option will instruct VSS to generate a Legend with Shifts 
listed separately from Explanations. If you do not select this option, Shifts and Explanations will be listed together 
according to the alphabetical order of their abbreviations. 

4 Click Print or Preview. 

To Edit Legend Items 

Sometimes, you will want to make changes to the attributes of the various shifts and explanations. To make this 
process easier, VSS allows you to edit items directly from the Legend window. 
1 Highlight the desired item in the Legend List Box. 
2 Click the Edit Tag button, or double click the item you wish to edit. 
3 Make your selections. 
4 Click OK. 
Note: If you change an item's abbreviation, the item is moved in the Legend List Box to reflect its new position 
according to alphabetical order. 

To Automatically Add Legends to Schedules 

To add the shifts and explanations at the end of schedules automatically, simply mark the Append Legends check box 
in the Print window. 

When the check box is marked, the legend is added to printed or published schedules. 

TIME‐OFF REPORT 
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Use this report to view lists of all your employees scheduled Off, plus days they’re not scheduled to work. You can 
quickly see when an employee has taken vacation, sick, or personal days, or days when an employee has not been 
scheduled. 

Note: This report works with the assigned Time‐Off function of VSS and blank cell dates. If you have specially defined 
time‐off shifts of your own, this report will not be accurate. 

To Run a Time‐Off Report 

1 Select Time‐Off from the Reports menu. 
2 Select the Start Date and End Date by clicking the calendars and selecting the appropriate dates. 
3 Mark the check box(es) for the days you wish to include in the query.  
4 Click Run. 
5 Make your selections in the Print Time‐Off window. 
6 Click Print or Preview. 

ON‐CALL REPORT 

Use this report to view lists of employee’s On‐Call assignments during a defined time period. 

Note: This report works with the VSS‐defined On‐Call shift. 

To Run an On‐Call Report 

1 Select On‐Call from the Reports menu. 
2 Select the Start Date and End Date by clicking the calendars and selecting the appropriate dates. 
3 Click Run. 
4 Make your selections in the Print On‐Call window. 
5 Click Print or Preview. 

PERSONAL SCHEDULES 

VSS gives you the flexibility to print customized individual schedules. You can print 1 to 42 day schedules, or a monthly 
calendar for selected staff. 

The 1 to 42 Day Personal Schedule 

1 Click the Reports menu and select Personal Schedules. 
2 Select 1 to 42 Day from the Personal Schedules menu. VSS displays the Personal 1 to 42 Day Schedule window. 
3 In the Names list box, select the name(s) you wish to print. 

Important! Each name you select is printed on a different page. To print schedules with multiple names per page, 
see Printing the current schedule or Staff Schedules. 

4 In the Start Date box, click the calendar to select the date you wish the schedule to begin on. 
5 Enter the total number of days (1 to 42) you wish the schedule to display. 
6 In the Contents box, select all items you wish to appear on the report. 
7 Click the Preview or Print button to run the report. 

The Monthly Calendar Personal Schedule 

1 Click the Reports menu and select Personal Schedules. 
2 Select Monthly Calendar from the Personal Schedules menu. VSS displays the Monthly Calendar window. 
3 In the Names list box, select the name(s) you wish to print. 

Important! Each name you select is printed on a different page. To print schedules with multiple names per page, 
see Printing the current schedule or Staff Schedules. 

4 In the Month to Print drop down list, click the arrow and select the desired month. 
5 In the Contents box, select all items you wish to appear on the report. 
6 Select the Start Calendar on Sunday if you wish the calendar to list the days of week beginning with Sunday. 

Note: If you wish the calendar to begin on the same day of week you selected when you defined schedule 
properties, deselect this option. 
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7 Click the Preview or Print button to run the report. 

STAFF SCHEDULES 

Staff Schedules are designed to list the names of staff that are scheduled on a particular day or range of days. VSS 
features customizable “1 to 42 day” and “calendar style” staff schedule formats. 

The 1 to 42 Day Staff Schedule 

1 Click the Reports menu and select Staff Schedules. 
2 Select 1 to 42 Day from the Staff Schedules menu. VSS displays the Personal 1 to 42 Day staff schedule window. 
3 If you are not going to select a Query, you should use the Names list box to select the name(s) you would like to 

appear on the printed schedule. Click the Select All button to instantly select all names in the list. Click the Clear 
All button to deselect all names. 

4 Multiple names may be selected by holding the mouse button down while moving up or down. To select multiple 
names at random, hold the Ctrl key down while making mouse selections. You must select at least one name 
before you can print the report 
Note: You can also use the Print Employee Numbers Only option. 

5 VSS also allows you to print reports using the Query function. You can use this feature to print vacation schedules, 
shift schedules, departmental schedules, etc. Click the Query button to select a query; refer to query selection and 
editing for more instructions.  

6 In the Start Date box, click the calendar to select the date you wish the schedule to begin on. 
7 Enter the total number of days (1 to 42) you wish the schedule to display. 
8 Select the total number of weeks you would like VSS to display per page. If you receive the truncation error 

message, you need to reduce your font size or lower the number of weeks per page option. 
Note: When selecting font sizes, you can manually enter sizes as low as 4 points. 

9 Enter the number of subsequent schedules after the Start Date and Number of Days that you want to print. As a 
result, you do not have to select a new date range each time you want to print a schedule. 

For example, if you enter: 
5 for the Number of Days from the Start Date 01/02/06 
2 for Subsequent 5 day schedules to print 
VSS will print 3 schedules for the following dates: 
01/02/06– 01/06/06 
01/09/06– 01/13/06 
01/16/06– 01/20/06 

10 In the Contents box, select all items you wish to appear on the report. 
11 Click the Print or Preview button to run the report.  

The Staff Calendar 

1 Click the Reports Menu and select Staff Schedules. 
2 Select Monthly Calendar from the Staff Schedules menu. VSS displays the Monthly Staff Calendar window. 
3 If you are not going to select a Query, you should use the Names list box to select the name(s) you would like to 

appear on the printed schedule. Click the Select All button to instantly select all names in the list. Click the Clear 
All button to deselect all names. 

4 Multiple names may be selected by holding the mouse button down while moving up or down. To select multiple 
names at random, hold the Ctrl key down while making mouse selections. 
Note: You must select at least one name before you can print the report. 

5 VSS also allows you to print reports using the Query function. You can use this feature to print vacation schedules, 
shift schedules, departmental schedules, etc. Click the Query button to select a query; refer to query selection and 
editing for more instructions.  

6 Select the Month to print. 
7 Select the total number of weeks you would like VSS to display per page. 
8 If you receive the truncation error message, you will need to reduce your font size or lower the number of weeks 

per page option. 
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Note: When selecting font sizes, you can manually enter sizes as low as 4 points. 
9 Enter the number of subsequent schedules after the Start Date and Number of Days that you want to print.  
10 In the Contents box, select all items you wish to appear on the report. 
11 Click the Print or Preview button to run the report. 

GROUP SCHEDULE 

This powerful staff schedule lets you separate personnel in up to 99 different groups in a convenient, one‐ to seven‐
day format. You can print multi‐departmental, multi‐location or any other types of multi‐divisional reports on a single 
sheet of paper. 

To Prepare a Group Schedule 

1 Click the Reports menu and select Staff Schedules. 
2 Select Group from the Staff Schedules menu. VSS displays the Group staff schedule window. 
3 In the Groups list box, select one or more groups for which you would like to print schedules. You do not have to 

print all group schedules. If you do want to print all groups, click the Select All button. 
4 In the Start Date box, enter the date you wish the schedule to begin on by selecting from the calendar. 
5 Enter the total Number of Days (1 to 7) you wish the schedule to display. 
6 Enter the number of subsequent schedules after the Start Date and Number of Days that you want to print. In the 

Contents box, select all items you wish to appear on the report. 
7 Click the Print or Preview button to run the report. 

To Define Groups 

1 Select the first “Undefined” group in the Group Schedule window and click the Define Group button. VSS displays 
the Select Query window. 

2 Add, edit, or create the query that you would like to represent the group you are defining; refer to query selection 
and editing for more instructions. 

To Sort Schedule Output 

There are times when you will want the information on the staff schedules to be sorted, or arranged, in a particular 
order. A common example would be a schedule that is sorted by name. 

VSS allows you to sort schedules by up to five different types of information: Name, Position, Shift (description), Start 
Time and Explanation. 

To sort a schedule by Position and by Name 

1 Click the Sort button. 
2 Select Position for the [1st] key. 
3 Select Name for the [2nd] key. 
4 All other keys [3rd ‐ 5th] should be set to None 
5 Click OK. 

To Select Name Format 

The Name Format option allows you to select an abbreviated form of names instead of the full names that were 
entered into the Name column of the schedule. This feature reduces the amount of horizontal space required on the 
report, and can also be used in conjunction with the sort feature to adjust the order that names appear on the report 
(sorted by first name or last name). 

For example: 

John Smith could be printed as “J Smith” or “JS” to allow more room for other information on the report. 

Note: There are a couple of name entering rules that must be followed before this function will work correctly. You 
must enter names in either one of two formats on the main schedule: 

First Name Last Name 
 or 
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Last Name, First Name   (Note the comma after the last name) 

If you have not entered names this way or have placed additional information in the Names area of the schedule, you 
should select the Default setting for the Name Format option. 

STAFF REPORTS 

Staff Reports provide specific information about your employees, including individual profiles, estimated costs, skills, 
and seniority status. 

Employee Profile reports provide contact information, employee number, hire date, skills, comments and photos. 

Use the Skill report to view or print employee skill set details, and the Seniority report to view or print seniority status 
by position. 

To Prepare Employee Profile Report 

1 Click the Reports menu and select Staff Reports. 
2 Select Profile from the Staff Reports menu and the Profile Report window is displayed. 
3 Use the Names list box to select the name(s) you would like to have in the report. Click the Select All button to 

instantly select all names in the list. Click the Clear All button to deselect all names. 
4 Enter a title for the report, if needed. 
5 To include employee photos, mark the check box. 
6 To have multiple employees included on each page, mark the check box. 
7 Click on the Print or Preview button to run the report. 

To Prepare Employee Skills Report 

1 Click the Reports menu and select Staff Reports. 
2 Select Skill from the Staff Reports menu and the Skill Report window is displayed. 
3 Use the Skills list box to select the skill(s) you would like to have in the report. Click the Select All button to 

instantly select all skills in the list. Click the Clear All button to deselect all skills. 
4 Enter a title for the report, if needed. 
5 Click on the Print or Preview button to run the report. 

To Prepare Employee Seniority Report 

1 Click the Reports menu and select Staff Reports. 
2 Select Seniority from the Staff Reports menu and the Seniority Report window is displayed. 
3 Use the Position list box to select the position(s) you would like to have in the report. Click the Select All button to 

instantly select all positions in the list. Click the Clear All button to deselect all positions. 
4 Enter a title for the report, if needed. 
5 Click on the Print or Preview button to run the report. 

ESTIMATED COST REPORT 

The Estimated Cost report is used to calculate hours scheduled, and to provide an estimate of labor costs for a given 
work period up to 42 days long. It should not be used as a substitute for any type of payroll report. 

To Obtain an Estimated Cost Report 

1 Note the date on the schedule you want the report to start. Or, you can click on the starting date in the schedule 
worksheet. 

2 Select Estimated Cost from the Reports menu. VSS displays the Estimated Cost Report window. 
3 Use the calendar to select the Starting Date of the report. The default date displayed is the date you highlighted 

previously in the schedule worksheet. 
4 In the Number of Days box, type in the number of days you want to include in your estimated cost report. 
5 Use the Names list box and the Edit Cost button to enter hourly or daily cost information. 
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To Enter Cost Information. (1) Select a name and then click the Edit Cost button. The Edit Employee Cost 
Information window appears with the name you selected. (2) Add or edit the Cost amount box. (3) Add or edit the 
Cost Entered By method. (4) Click OK. 
Note: Selecting the Hour option causes VSS to calculate estimated costs based on the number of hours 
scheduled. If you select the Day option, VSS calculates estimated costs regardless of how many hours were 
actually worked. Use the Day option for salaried staff, or in situations that do not require that an hourly cost be 
maintained. 

  Important! VSS will not calculate overtime if you select the Day option. 
6 Select which staffs’ schedule and cost data you want to print; only those highlighted will print. 

Note: You can click on the Select All or Clear All buttons to select or deselect all staff in the list. 
7 Select the Hide report in Read‐Only mode option if you want to hide this report from anyone who does not have 

read‐write access password privileges to the schedule. This feature applies only to the multi‐user version of VSS. 
To set up read/write access passwords and read‐only access passwords, refer to Define Properties. 

8 In the Daily Overtime Adjustment box, type in a Daily Threshold and Factor. The Daily Threshold is the required 
number of hours a person must work before receiving any overtime adjustment. Typically, you would require a 
person to work at least eight hours in a day before they receive any overtime. Type in the factor to calculate the 
overtime adjustment for scheduled work that exceeds the threshold hours. For example, if you use a factor of 1.0, 
VSS will NOT calculate overtime. If you use a factor of 2.0, the overtime adjustment would be twice the hourly 
cost. 
Note: The VSS default is set for not calculating daily overtime. 

9 In the Period Overtime Adjustment box, type in the number of days, threshold, and a factor for a specified period 
required for overtime. In the Days box, type in the number of days in the period (usually 7 days or 1 week). In the 
Threshold box, type in the number hours that must be worked before a person will start receiving overtime 
(usually 40 hours). In the Factor box, type in number that cost should be multiplied by to calculated period 
overtime. 

For example: DAYS = 7 / THRESHOLD = 40 / FACTOR = 1.5 
If staff normally receives $8.00/hour and work more than 40 hours in 7 days, they will receive $12/hour for 
each additional (overtime) hour. This is equivalent to TIME AND A HALF. 

Note: VSS defaults to the settings in the example above. 

SAVED REPORTS 

For Premier users only! 

If you print regular schedules for departments, positions, or skills, you can use this feature to access and print these 
common reports right from your Reports menu. 

For example, if you print weekly schedules for each department, you can now save your setup preferences and print 
them all in seconds. 

Note: This feature is for Staff Schedules only and is based on your File > Print settings versus your current view 
displays at the time of printing. 

To Save a Report 

1 Click the Reports menu and select Staff Schedules. 
2 Choose the report type you wish to set up for saving, and make all necessary preference selections in the report 

window. Refer to the Staff Schedules topic for assistance, if needed. 
3 Click the Save button in the lower left hand corner of the window. 
4 Enter the name of your saved report. 
5 Click Close. 

To Access a Saved Report 

From the Reports menu, select Saved Reports and choose from the list of report names displayed. 
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CUSTOM COVER PAGES 

Add a Microsoft Word document as a cover to your schedules and reports. Communicate notices, instructions, and 
other information important to include when you share the schedule or report with others. 

To Add Covers to Schedules & Reports 

1 From the Reports menu, make your schedule or report selection. 
2 In the schedule/report window, click the Preview button. 
3 Click the Add button in the menu bar at the top of the preview. 
4 Enter the file name, or click the Browse button to locate the file you wish to add. 
5 Click Open. 
6 Click OK to add the document as a cover to your schedule or report preview. 
7 Save, print, or e‐mail your schedule or report. 

PREVIEWING & PUBLISHING REPORTS 

VSS allows you to preview an image of a report before it is printed or published. You can publish the report as an 
HTML document that can be viewed by any Inter‐net/Intranet browser, or as a PDF file you can e‐mail to others. 

To Preview and Publish Reports 

1 Access the preview and publish functions, by clicking the Preview button within the Print window, or within any 
report window. 

2 Select preview and publish options. 
Add. Use this function to add any Microsoft Word document for other information to be included with the report 
you’re sharing, such as a cover letter, announcements, or workplace notices. 
Save As. Click the Save As button to display the Save As window where you can choose to publish in PDF or 
HTML formats. 
Folder to Publish to. This field contains the destination drive and directory that the published report files will be 
written to. 
The default directory for a Microsoft Windows system is: C:\Documents and Settings\All Users\Documents\Visual 
Staff Scheduler\Published 
Browse. Click this button to change the drive/directory settings. VSS will create the directory if it does not already 
exist. Note: We do not recommend that you use the VSS application directory (normally C:\Program Files\VSS\) 
to publish your reports to. 
Print. Click the Print button to print the report you’re previewing. 
E‐mail. Click the E‐mail button to e‐mail reports in PDF format to participants or to any other person outside your 
business. 
Previous/Next. Use the Previous and Next buttons to view different pages in a multiple page document. 
Zoom. Click the Zoom button to toggle between detailed (zoom in) and full (zoom out) images of a page. 
Close. Click the Close button to exit. 

Note: VSS does not automatically transfer documents to Internet Web Servers. You will need to transfer the files 
created with your FTP software before documents can be viewed by other Internet users. 

TIP:  If you would like users to be able to print schedules from their HTML browsers, you may need to format your 
reports so that they will fit an area slightly less than 8 1/2” X 11” paper. For more information on page orientation and 
paper size, refer to “Report Setup.” 
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Using Enterprise Reporting 

For Premier users only! 

What is Enterprise Reporting? It is a powerful tool that allows you to view information across multiple schedule files 
covering your entire organization. 

For organizations that have more than one schedule managing employees across different locations, departments, or 
supervisors, Enterprise Reporting delivers an overall view of scheduled and available staff members – all sorted and 
grouped by schedule file.  

Here are just a few ways you can use Enterprise Reporting: 

• E‐mail or publish schedules and reports as PDF documents that encompass your entire organization. 

• Locate specific employees or other scheduling information quickly with the interactive report viewer. 

• Quickly jump to sections of schedules or reports with the contents navigator. 

• Gain access to employee profile information, or e‐mail an employee, by clicking an employee’s name within the report 
viewer. 

HOW DOES IT WORK WITH VSS? 

Enterprise Reporting is an interactive tool that finds the schedule and employee information you need from within 
multiple VSS schedule files and delivers the details in a convenient report format. 

A Schedule Files list displays the VSS schedule files that hold schedule and employee information you wish to search 
for your report details. 

A Reports list gives you easy access to the eight enterprise reports you have to choose from, including: 

• Daily Schedule 

• Weekly Schedule 

• Shift Schedule 

• On‐Call Schedule 

• Not Scheduled 

• Time‐Off 

• Hourly Coverage 

• Estimated Cost 

MENU OPTIONS 

File 

Use your File menu to access System Options and to Exit the reporting tool. 
• System Options. Select your time format, week start day, and password in this window. 
• Time Format. Select either Standard or Military time. 
• Week begins on. Choose the beginning day of your week, such as Monday. 
• Password. Enter a password to be used for protecting access to Enterprise Reporting. Please note: This password 

is valuable if you use a shared PC and do not wish to have others viewing the details of the various schedules and 
employees in your organization. 

• Exit. You will return to VSS when you choose Exit. 
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Schedule Files 

Your Schedule Files list will display the VSS file name for each one you wish to include when generating your reports. 
• Prepare the List. To add, edit or refresh this list, go to the List menu. Please note: You can only add the files you 

have permission to access. VSS files that are password protected will not be accessible here unless you have been 
authorized to view the information and have received the appropriate password from the file owner. 

• Prepare for a Report. When you are ready to view a report, simply mark the checkbox of each VSS file you want 
included in that report. You can make changes to these selections at any time. 

Reports 

Your Reports list displays the eight options available for enterprise reports. 

Enterprise Reporting gives you the option to view, print, e‐mail or publish each of these reports. Please note: To send 
reports, an e‐mail client such as Microsoft’s Outlook or Outlook Express, is required in order for the e‐mail function to 
work. VSS will not work with web mail systems. 
• Choose the Report. When you are ready to view a report, simply click the type of report you wish to view. You 

can choose from: 
1 Daily Schedule  
2 Weekly Schedule  
3 Shift Schedule  
4 On‐Call Schedule  
5 Not Scheduled  
6 Time‐Off  
7 Hourly Coverage  
8 Estimated Cost  
9 Set up the Report 

• After choosing the report, a set up window will be displayed giving you selections for dates, report names, and 
sorting. When you are done making your selections, click OK to display the report. 

• View and Share the Report. Your report is displayed in a viewing window. From this window, you will have the 
options to save, send, or print the report. 

• Other Options. Here you will also find options for Save, Send, and Print. 

List 

Use your List menu to Add, Edit, and Refresh the schedules included in your reporting tool. These options are also 
available using the buttons to the right of the Enterprise Reporting screen. 
• Add. Choose add to include VSS files in your Schedule Files list that are available for access. Please note: VSS files 

that are password protected will not be accessible by you unless you have been authorized to view the 
information and have received the appropriate password from the file owner. 

• Edit. Use this option to add or remove VSS files within your Schedule Files list at any time. 
• Refresh. Because this is an interactive tool, you will want to use the refresh option to capture any changes that 

may have been made since your last report viewing. 

Help 

Use this menu to not only access help contents, but also to check for software updates and view the specifications of 
your software version. The options in the Help menu are specific to Enterprise Reporting. For VSS Help options, you 
will want to exit this tool and return to VSS. 
• Contents. Review these topics to learn more about Enterprise Reporting. 
• Check for Updates. This option will update your software for the current version only. Once a new version of the 

software becomes available, you will no longer receive updates for this version. Please note: Customers on service 
agreement plans will automatically receive all updates. Call Customer Service at 701‐235‐5226 for details. 

• About. Displays the specifications of your software version. 

ACCESSING ENTERPRISE REPORTING 

There are two ways to access Enterprise Reporting: 
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• When you launch VSS Premier, you will see a Welcome screen that includes a link to Enterprise Reporting. 
• Or, access Enterprise Reporting from the Reports menu. 

E‐mailing Schedules & Reports 

VSS allows you to distribute personal work schedules to any staff member with an e‐mail address. You can either e‐mail 
personal schedules as text or any schedule or report as a PDF (portable document format) file. 

Note: E‐mailing only works with compatible Microsoft Windows e‐mail programs such as Outlook and Outlook Express. If 
you have difficulty e‐mailing schedules or reports, consult with your system administrator. 

DEFINING E‐MAIL AND DATA EXPORT FUNCTIONS 

The Define E‐mail and Data Export function gives you the ability to set up how you want the E‐mail and Data Export 
functions to work before you begin mailing schedules and exporting schedule data. The E‐mail function is accessed by 
clicking the E‐mail quick‐action button in the toolbar, going to any of the Preview windows when printing reports and 
schedules, or performing a File > Print function.  

Important! VSS requires an e‐mail client such as Microsoft’s Outlook or Outlook Express in order for the e‐mail 
function to work. VSS will not work with web mail systems. 

To Define How E‐mail and Data Export Functions Work 

1 From the File menu, select Properties and click the E‐mail tab. The program displays check boxes for setting E‐
mail options. 

2 Make selections for the following options. 
Before sending schedules. (1) Display default E‐mail editor ‐ after clicking the E‐mail button from the Preview 
window, the program automatically displays your e‐mail editor, such as Outlook or Outlook Express; (2) Display 
default address book ‐ after clicking the E‐mail button from the Preview window, the program automatically 
displays your e‐mail address book from which you can select your addresses; and, (3) Send directly to Outbox ‐ 
after clicking the E‐mail button from the Preview window, the program automatically displays a message stating 
that it will attempt to send the following messages on your behalf. When you select Send, the program places the 
schedules in your outbox and doesn’t display the e‐mail editor.  
When mailing schedules.  (1) Send copy to participants ‐ the program automatically sends a copy of the schedule 
to all names referenced in the schedule file; (2) Ignore missing or invalid addresses ‐ when mailing schedules, the 
program ignores names that do not have an e‐mail address or an invalid e‐mail; otherwise, the program will 
prompt you when addresses are missing or invalid; (3) Request a return receipt ‐ the program automatically 
returns a receipt when the schedule has been sent. 

3 Click the Data Export tab. The program displays check boxes and fields for setting Data Export options. 
4 Make the following selections. 

Enable Auto Export. Check this option to automatically export your schedule data whenever you select Save 
from the File menu. VSS saves the file to the default VSS directory. The file is saved as a .csv file and the file name 
is the same as the name of the schedule; for example, sample1.csv.  
Date Range. Maximum days prior to current date ‐ Enter the number of days data in the schedule before the 
current date that you want to export. 
Maximum days after current date. Enter the number of days data in the schedule after the current date that you 
what to export. 
Prompt before exporting. Check this option if you want VSS to display a prompt before exporting the file, asking: 
Do you wish to export schedule data at this time? 
Require Reference Numbers. Check this option if you want reference numbers recorded at the beginning of each 
record and in the first column of the schedule data file. Export Reference Numbers must be unique for each 
person.  
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Note: All persons must have Export reference Numbers defined before VSS can export data. You can use 
reference numbers to associate scheduling information with payroll and time and attendance records, rather than 
using names. 

5 Click OK. 

E‐MAILING MESSAGES 

Use the E‐mail button to send your employees messages right from the main schedule window. Send messages about 
what you’re scheduling, such as training dates, upcoming time‐off, or other related information, immediately without 
leaving your schedule worksheet. 

Note: You can also use the E‐mail button in the Employee Profile window. 

To Send an E‐Mail Message 

1 Locate the name and click the appropriate row. 
2 Click the E‐mail button in the toolbar. 
3 Enter the message in your default e‐mail client as usual. 
4 Click Send. 

Note: If you want to send messages to a group of recipients at one time, refer to the following procedures for 
more information. 

E‐MAILING PERSONAL SCHEDULES AS TEXT 

VSS allows you to e‐mail schedules as a text file. 

Important! VSS requires an e‐mail client such as Microsoft’s Outlook or Outlook Express in order for the e‐mail 
function to work. VSS will not work with web mail systems. 

To E‐mail Schedules as a Text File 

1 Select E‐mail Memo from the Reports menu. The program displays the E‐mail Memo window. 
2 Mark the Include personal schedule with memo option. 
3 Select one or more recipients to whom you wish to e‐mail a personal schedule. 

If the e‐mail address does not appear after the person’s name, click Edit E‐mail Address to enter his or her 
address. 

4 Enter the Start Date and the Number of Days you want to e‐mail (1 to 42 days). 
5 Enter a Title/Subject. This appears as the subject in the recipient’s e‐mail message. 
6 In the Contents group box, select one or more of the schedule data that you want included in the e‐mail. 
7 If you want to receive a receipt that the message was delivered, check the Request a return receipt option. 
8 Click the Edit Memo button and enter or change the message that appears before the schedule data. 

Note: Each recipient will receive their own personal schedule, however the memo included with each message 
will be the same for each recipient. 

9 Click Preview to review the message(s) to be e‐mailed. 
10 Note: You can also use the e‐mail function from the Preview window of VSS reports and schedules to e‐mail 

reports/schedules as PDF documents. 
11 Click Close if you previewed the message; otherwise click Send to e‐mail the schedule data to the selected email 

addresses. 

E‐MAILING SCHEDULES AND REPORTS IN PDF FORMAT 

You can e‐mail schedules or reports to others who are schedule participants or to any other person outside your 
business.  

Important! VSS requires an e‐mail client such as Microsoft’s Outlook or Outlook Express in order for the e‐mail 
function to work. VSS will not work with web mail systems. 

To E‐mail in PDF Format 
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1 Click File and select Print. VSS displays the Print window. 
Note: You can e‐mail schedules and reports from any of the Preview windows when performing a File>Print 
function, or when previewing any Reports (i.e. Reports, Personal Schedules). 

2 Select the name(s) for those schedules you want to e‐mail. 
3 If necessary, select any of the schedule options from the Print window and/or click the Query button to select a 

report. 
4 Click the Preview button to display the schedule/report. 
5 Click the E‐mail button at the top of the Preview window. VSS starts up your e‐mail client, and then the E‐mail 

editor (i.e. Microsoft’s Outlook or Outlook Express.) 
6 Enter an e‐mail address(es) and a message. Note that VSS automatically enters a title in the Subject line (i.e. 28 

Day) and attaches the schedule/report to the e‐mail as a PDF file (i.e., 28 Day.pdf). 
7 Click Send.  

VSS has several choices for how you want to send copies of your schedules and reports and to whom. For example, if 
you selected the option to “Send copy to recipients when e‐mailing schedules,” VSS would automatically populate 
your “To” address line with the e‐mail addressees of those who appear on the schedule. 

Exporting Schedule Data 

VSS provides additional capability by allowing you to export schedule data to a separate file or to the clipboard. Exporting 
data enables you to share data with time and attendance systems, databases, spreadsheets, report writers, and other 
external applications and hardware. 

There are two different methods for exporting data: 

• Export the entire schedule data for a desired date range automatically 

• Export selected data and specific schedule contents manually 

EXPORTING SCHEDULE DATA 

The Schedule Export feature has been provided as a quick and easy way for you to use schedule data from VSS in 
other applications. You can use this feature to: 

• Use VSS data in spreadsheet applications 

• Use VSS data in word processing applications 

• Create custom schedules 

• Create custom cost reports 

• Create custom graphs or charts 

• E‐mail schedules to personnel 

• Archive schedule information 

To Export Schedule Data 

1 Select Print from the File menu. 

2 Select the desired staff from the Names list box. 

3 Click the Export button. VSS displays the Export Schedule Data window. 

4 Select the type of information you would like to export (i.e. Position, Explanations, etc.). 

5 Select the appropriate data format for the application that will be accessing the exported data. 

Note: You should always use Tab Delimited for normal word processing applications. 
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Stacked Columns. If you have selected more than one type of data to export, you can elect to have this 
information stacked in one column verses multiple columns for each different item selected. 

Example1: 
Contents = Name, Position, and Start1,End1 with Stacked Columns option selected. 
Tab Delimited and Separate Records selected. 

Note that the start and end times will be displayed together, stacked in the same column. 
Example2: 
Contents= Name, Position, and Start1, End1 with Stacked Columns option not selected. 
Tab Delimited and Separate Records selected. 

Note that the start and end times will be placed next to each other instead. 
Separate Records. Selecting this option will cause VSS to separate each staff record with a blank row or line. 

6 Click your export preference. 
Export to Clipboard. Click this button to export the schedule data directly to the Windows system clipboard. You 
can then run other applications and use their paste function to import this information. 
Export to File. Click this button to save the exported information to a disk file. 

EXPORTING SCHEDULE DATA AUTOMATICALLY 

With VSS you can automatically export all schedule data to a comma separated (*.csv) file every time you click Save. 
In addition, you can specify that you want the exported file to include an Export Reference Number for each person for 
associating schedule information with payroll and time and attendance records.   

To Export Automatically 

1 Select Properties from the File menu. 
2 Click the Data Export tab to display the export options. 
3 Mark the Enable Auto Export option to allow the automatic export of your schedule data whenever you select 

Save from the File menu. 
Note: VSS saves the file to the default VSS directory. The file is saved as a .csv file and the file name is the same as 
the name of the schedule, for example, sample1.csv. 

4 Mark the Require Employee Numbers to assign reference numbers at the beginning of each record and in the first 
column of the schedule data file. Employee Numbers must be unique for each person and all persons must have 
Employee Numbers defined before VSS can export data. 
Note: You can use reference numbers to associate scheduling information with payroll and time and attendance 
records, rather than using names. 

5 Enter or select date range information. 
Maximum days prior to current date. Enter the number of days prior to today’s date you want to export. 
Maximum days after current date. Enter the number of days after today’s date you want to export. 

6 Mark the Prompt before exporting option if you want VSS to display a prompt before exporting the file. It will 
display the Do you wish to export schedule data at this time? message. 

7 Click OK. 

EXPORTING SCHEDULE DATA FOR A RANGE OF DATES 

VSS allows you to export all schedule data for a specified date range to a comma separated (*.csv) file for use in other 
applications. 

To Export Range of Dates 

1 Click the File menu and select Export Data. 
2 Enter the starting and ending dates of schedule data you want included, in the From and To boxes, respectively. 
3 Click the Export button. VSS displays the Export to window. 
4 Go to the folder where you want to save the file. 
5 Enter the desired file name, then click Save. The file is saved in a *.csv file format. 
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Publishing Schedules & Reports 

VSS allows you to publish any report or schedule in PDF (Portable Document Format) or HTML (HyperText Markup 
Language) formats. You can upload your schedules to your corporate Intranet and allow employees to access company 
schedules using any Internet browser. 

You can also publish or e‐mail individual or group schedules in PDF format, enabling employees to view schedules in 
Adobe’s Acrobat Reader. (You can download Acrobat Reader, free of charge, from http://www.adobe.com.) 

PUBLISHING SCHEDULES IN HTML FORMAT 

You can publish schedule data to HTML from any of the Print>Preview functions. 

To Publish in HTML 

1 Select Print from the File menu. VSS displays the Print window. 
2 Select the desired Names and other options such as Days to Print, Start Dates, Number of Days, Sort and Query 

options. 
3 Click the Preview button. VSS displays the selected schedule data report on your screen. Notice at the top of the 

Preview window you can Zoom in and out to view the schedule, Save As or E‐mail schedules, and Close the 
Preview window. 
Note: If you click E‐mail from the Preview window, the program will attach the schedule or report as a PDF file to 
an email message. 

4 Click the Save As button. The Save As window is displayed. 
5 Enter or locate the folder where the HTML file is to be saved. 

Note: VSS defaults to C:\Documents and Settings\All Users\Documents\Visual Staff Scheduler\Published folder. 
6 Enter a file name (using up to 255 characters), or accept the default name, and be sure HTML is selected in the 

Save as Type box. 
7 Click the Save button to create a report in HTML. 

PUBLISHING SCHEDULES IN PDF FORMAT 

Publish individual or group schedules in Adobe Acrobat’s PDF format for other staff to view. 

To Publish in a PDF 

1 Select Print from the File menu. VSS displays the Print window. 
2 Select the desired Names and other options such as Days to Print, Start Dates, Number of Days, Sort and Query 

options. 
Note: You can also publish a schedule in PDF format from any of the Report Preview windows. 

3 Click the Preview button. VSS displays the selected schedule data report on your screen. Notice at the top of the 
Preview window you can Zoom in and out to view the schedule, Save As or E‐mail schedules, and Close the 
Preview window. 
Note: If you click E‐mail from the Preview window, the program will attach the schedule or report as a PDF file to 
an email message. 

4 Click the Save As button. The Save As window is displayed. 
5 Enter or locate the folder where the PDF file is to be saved. 

Note: VSS defaults to C:\Documents and Settings\All Users\Documents\Visual Staff Scheduler\Published folder. 
6 Enter a file name (using up to 255 characters), or accept the default name, and be sure PDF is selected in the Save 

as Type box. 
7 Click the Save button to create the PDF report. 
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Automatic Schedule Backup 

VSS provides the ability to automatically create a backup file each time you save a schedule file. 

AUTOMATIC BACKUP 

For each schedule file, VSS will save up to five separate backup files (*.vb1 through *.vb5).  In addition, you can revert 
to the most recent backup file. 

To Recover a Damaged File 

1 When you open a damaged file, VSS displays the message: “VSS cannot open the selected schedule file. This file 
may be corrupt or not a valid VSS file.” 

2 Click OK to continue. VSS displays the message: “VSS has located one or more backup copies of the schedule file 
you are attempting to open. Do you want to open one of these backups?” 

3 Click Yes to continue. VSS displays the Open File window.  

4 Select the most recent backup file, which is the file with the vb1 extension; for example, Schedule.vb1. 

1 Select Open from the File menu. 
2 Click No to saving changes to the currently open schedule file. The Open File window appears. 
3 Select the file types: Schedule Backup Files (*vb?). 
4 Select the most recent backup file, which is the file with the vb1 extension; for example, Schedule.vb1 
5 Click Open to revert to the last saved version of your schedule file. 

Accessing the Staff Files Program 

Staff Files is HR software, purchased separately, that can be used in conjunction with VSS to store detailed, staff‐specific 
information.  

ACTIVATING STAFF FILES 

This section discusses the Staff Files program in more detail so you can see how the two work together. 

To Activate the Staff Files Application 

Click the Staff Files button. 

The Staff Files application loads and activates the staff record for the currently selected row in VSS 

Note: Staff Files attempts to match the name in VSS to a name in its database. If Staff Files cannot locate an exact 
match, it displays a search window and you need to locate the correct staff record manually. 

“VSS cannot locate the Staff Files application.” If you receive this message after pressing the Staff Files button, you 
should: (1) Make sure that Staff Files has been correctly installed on your system. See the Staff Files manual for more 
information on installing Staff Files; and (2) Connect the Staff Files application to VSS. 

To Connect Staff Files to VSS 

1 Select Properties from the File menu. 
2 Press the Connect button. 
3 Locate the drive/directory your Staff Files application was installed in. 
4 Locate then click the file SF2_APP.EXE. 
5 Press the OK or Open button. 
6 Close the windows. 

You should now be able to activate Staff Files from within VSS. 
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WHAT IS STAFF FILES? 

Staff Files gives you an easy way to manage employee information. 

Staff Files is a comprehensive, PC‐based filing system designed for all of your personnel needs. Staff Files’ quick‐tab 
navigation system lets you find the information you are seeking, and its flexible printing/reporting options lets you put 
it in a format for others to see.  

With Staff Files, you can store all types of personnel information and, through the use of definable fields, specify the 
information that is important to you and your company. It even has a place to store a person’s photo. To ensure 
privacy, Staff Files offers a multi‐level password structure so others can only access the information you want them to. 

You can perform thorough evaluations, document training information and many other duties traditionally involving 
tedious paperwork. Its built‐in reminder system makes sure you stay on top of the details.  

The Staff Files system makes keeping accurate records effortless. A well‐organized system can help solve 
misunderstandings between you and your staff, and help avoid costly litigation and save you time. 

Staff Files is the perfect solution for today’s managers and HR professionals who need a better way to store, retrieve 
and safeguard staff data and information. 

• Safeguard vital information 

• Track staff performance 

• Perform comprehensive evaluations 

• Improve data management 

• Track vacation and time off 

• Enhance record accuracy 

• Reduce legal exposure 

• Save time 

To order Staff Files, call 1‐800‐874‐8801. For more information on Staff Files, visit our website at www.abs‐usa.com. 
You can also click Internet from the menu bar and select ABS Online, or click our logo located in the upper right‐hand 
corner of the program window. 

Atlas Business Solutions, Inc. 
3330 Fiechtner Drive SW 
Fargo, ND 58103 
Phone: 1‐800‐874‐8801 
Fax: 1‐701‐280‐0842 

End‐User Agreements 

SINGLE‐USER AGREEMENT 

PLEASE READ THIS DOCUMENT CAREFULLY BEFORE USING THIS SOFTWARE 

By using this computer program ("Software"), you agree to become bound by the terms of this Agreement. If you do not 
agree to the terms of this Agreement, do not use the Software and promptly return the package within 10 days to the 
place where you obtained it for a full refund. 

 

This Software is sold to you (owner of the product) by Atlas Business Solutions, Inc. ("ABS"), for use only under the terms 
of this Agreement, and ABS reserves any rights not expressly granted to you. 
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1.  Uses.  This Agreement allows you to: 

(a) Use the Software on a single microcomputer at a time, except the Software may be executed from a common disk 
shared by multiple CPUs provided that one authorized copy of the Software has been purchased from ABS for each CPU 
executing the Software. ABS does not, however, guarantee that the Software will function properly in your multiple‐CPU, 
multi‐user environment. The Software may not be used with any gateways, bridges, modems, and/or network extenders 
that allow the Software to be used on multiple CPUs, unless one authorized copy of the Software has been obtained from 
ABS for each CPU or terminal executing the Software. 

(b) Make one copy of the Software in machine‐readable form solely for backup purposes. The Software is protected by 
United States copyright law. You must reproduce on each copy the copyright notice and any other proprietary legends 
that were on the original copy supplied by ABS. 

2.  Restrictions: 

You may not distribute copies of the Software to others or electronically transfer the Software from one computer to 
another over a network and/or zone. The Software contains trade secrets and to protect them you may not decompile, 
reverse engineer, disassemble, crossassemble or otherwise change and/or reduce the Software to any other form. You 
may not modify, adapt, translate, rent, lease, loan, resell for profit, distribute, network or create derivative works based 
upon the Software or any part thereof.   

3.  Termination: 

This Agreement is effective until terminated. This Agreement will terminate immediately without notice from ABS if you 
fail to comply with any provision of this Agreement Upon termination you must destroy the Software and all copies 
thereof. You may terminate this Agreement at any time by destroying the Software and all copies thereof.  

4.  Export Law Assurance: 

You agree that the Software will not be shipped, transferred, or exported directly into any country prohibited by the 
United States Export Administration Act and the regulations thereunder nor will be used for any purpose prohibited by the 
Act. 

5.  Limited Warranty, Disclaimers, Limitation of Remedies and Damages: 

ABS' warranty on the media, including any warranty of merchantability or fitness for a particular purpose, is limited in 
duration to thirty (30) days from the date of the original retail purchase of this product. After that period, if a disk fails to 
work or if a disk becomes damaged, you may obtain a replacement disk by returning the original disk. Contact ABS for 
instructions on obtaining replacement disks. 

The replacement warranty set forth above is the sole and exclusive remedy against ABS for breach of warranty, express or 
implied, or for any default whatsoever relating to the condition of the Software. ABS makes no other warranties or 
representation, either expressed or implied, with respect to this Software or documentation, its quality, merchantability, 
performance, or fitness for a particular purpose. As a result, this Software is sold with only the limited warranty with 
respect to diskette replacement as provided above, and you, the owner, are assuming all other risks as to its quality and 
performance. In no event will ABS or its developers, directors, officers, employees, or affiliates be liable for direct, indirect, 
special, or consequential damages (including damages for loss of business profits, business interruption, loss of business 
information and the like) resulting from any defect in this Software or accompanying documentation or arising out of the 
inability to use the Software or accompanying documentation even if ABS, an authorized ABS representative, or an 
affiliate has been advised of the possibility of such damage.   

No oral or written information or advice given by ABS, its dealers, distributors, agents, affiliates, developers, directors, 
officers, or employees shall create a warranty or any way increase the scope of this warranty. Some states do not allow the 
exclusion or limitation of implied warranties or liabilities for incidental or consequential damages, so the above limitation 
and exclusion may apply to you. This warranty gives you the specific legal rights, and you may also have other rights that 
vary from state to state. 

6.  Copyright Notice: 
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This Software and accompanying manual (or documentation) are copyrighted with all rights reserved by Atlas Business 
Solutions, Inc. Under United States Copyright Laws, the Software and its accompanying documentation may not be 
copied in whole or in part, except in normal use of the Software or to make a backup copy for archival purposes only. Any 
other copying or selling or otherwise distributing this Software is hereby expressly forbidden. 

 

MULTI‐USER AGREEMENT 

PLEASE READ THIS DOCUMENT CAREFULLY BEFORE USING THIS SOFTWARE 

By using this computer program ("Software"), you agree to become bound by the terms of this Agreement. If you do not 
agree to the terms of this Agreement, do not use the Software and promptly return the package within 10 days to the 
place where you obtained it for a full refund. 

This Software is sold to you (owner of the product) by Atlas Business Solutions, Inc. ("ABS"), for use only under the terms 
of this Agreement, and ABS reserves any rights not expressly granted to you. 

1.  Uses. This Agreement allows you to: 

(a) Use the Software on multiple microcomputers at a time. The maximum number of users is limited to the number 
indicated on your multi‐user license card. The Software may be executed from a common disk shared by multiple CPUs or 
terminals provided that one authorized copy of the Software has been purchased from ABS for each CPU or terminal 
executing the Software. ABS does not, however, guarantee that the Software will function properly in your multi‐user 
environment. The Software may not be used with any gateways, bridges, modems, and/or network extenders that allow 
the Software to be used on multiple CPUs or terminals, unless one authorized copy of the Software has been obtained 
from ABS for each CPU or terminal executing the Software. 

(b) Install the software on one computer for each copy purchased, unless the computer is a server providing multi‐user 
capabilities using Citrix Metaframe, Windows Terminal Server or similar products (Application Server). If the software is to 
be installed on an Application Server, a purchased copy is required for each unique user connecting to the Application 
Server. 

(c) Make one copy of the Software in machine‐readable form solely for backup purposes. The Software is protected by 
United States copyright law. You must reproduce on each copy the copyright notice and any other proprietary legends 
that were on the original copy supplied by ABS. 

2.  Restrictions: 

The Software contains trade secrets and to protect them you may not decompile, reverse engineer, disassemble, 
crossassemble or otherwise change and/or reduce the Software to any other form. You may not modify, adapt, translate, 
rent, lease, loan, resell for profit, distribute, network or create derivative works based upon the Software or any part 
thereof. 

3.  Termination: 

This Agreement is effective until terminated. This Agreement will terminate immediately without notice from ABS if you 
fail to comply with any provision. Upon termination you must destroy the Software and all copies thereof. You may 
terminate this Agreement at any time by destroying the Software and all copies thereof.  

4.  Export Law Assurance: 

You agree that the Software will not be shipped, transferred, or exported directly into any country prohibited by the 
United States Export Administration Act and the regulations thereunder nor will be used for any purpose prohibited by the 
Act. 

5.  Limited Warranty, Disclaimers, Limitation of Remedies and Damages: 

ABS' warranty on the media, including any warranty of merchantability or fitness for a particular purpose, is limited in 
duration to thirty (30) days from the date of the original retail purchase of this product. After that period, if a disk fails to 
work or if a disk becomes damaged, you may obtain a replacement disk by returning the original disk. Contact ABS for 
instructions on obtaining replacement disks. 
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The replacement warranty set forth above is the sole and exclusive remedy against ABS for breach of warranty, express or 
implied, or for any default whatsoever relating to the condition of the Software. ABS makes no other warranties or 
representation, either expressed or implied, with respect to this Software or documentation, its quality, merchantability, 
performance, or fitness for a particular purpose. As a result, this Software is sold with only the limited warranty with 
respect to diskette replacement as provided above, and you, the owner, are assuming all other risks as to its quality and 
performance. In no event will ABS or its developers, directors, officers, employees, or affiliates be liable for direct, indirect, 
special, or consequential damages (including damages for loss of business profits, business interruption, loss of business 
information and the like) resulting from any defect in this Software or accompanying documentation or arising out of the 
inability to use the Software or accompanying documentation even if ABS, an authorized ABS representative, or an 
affiliate has been advised of the possibility of such damage. 

No oral or written information or advice given by ABS, its dealers, distributors, agents, affiliates, developers, directors, 
officers, or employees shall create a warranty or any way increase the scope of this warranty. Some states do not allow the 
exclusion or limitation of implied warranties or liabilities for incidental or consequential damages, so the above limitation 
and exclusion may apply to you. This warranty gives you the specific legal rights, and you may also have other rights that 
vary from state to state. 

6.  Copyright Notice: 

This Software and accompanying manual (or documentation) are copyrighted with all rights reserved by Atlas Business 
Solutions, Inc. Under United States Copyright Laws, the Software and its accompanying documentation may not be 
copied in whole or in part, except in normal use of the Software or to make a backup copy for archival purposes only. Any 
other copying or selling or otherwise distributing this Software is hereby expressly forbidden. 

 

Trademarks 

Visual Staff Scheduler is a registered trademark of Atlas Business Solutions, Inc. Staff Files is a registered trademark of 
Atlas Business Solutions, Inc. Adobe and Acrobat are registered trademarks of Adobe Systems, Inc. Microsoft Windows 
and Windows 2000/XP/Vista are registered trademarks of Microsoft Corporation. IBM is a registered trademark of 
International Business Machines Corporation. 

All other product names are copyright and registered trademarks/trade names of their respective owners. 
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